@ MOTOROLA

/ns,defar,

User's Guide




Page)yriter 2000X

0 Installing the Battery
a. Hold the pager face down.

b. Place your thumb on arrow in center of the battery door.
Press down and slide the battery door away from center of
your pager.

c. Match positive £) marking on battery with two-contact
side of pager’s battery compartment and negatiye (
marking with one-contact side of battery compartment.

d. Ensure lift tab is underneath,
not on top of battery. The tab
is designed to help lift battery
out of compartment when yot
remove it. g

e. Insert battery into battery
compartment at an angle
toward outer edge of pager,
then press battery down into
place.
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f. Fold the protruding lift tab down on top of the battery, and
slide the battery door back on.

O Installing the Charger

g. Plug one end of LEDs
transformer into
back of charger \
and other end into
any standard
120Vac outlet. z

h. Press pager firmly .« £
into charger until
it SNAPS INTO =4 -
PLACE. Ensure
the red LED light = LEDs
on the charger goes on.
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[0 Charging the Battery

Open the front flip on the
pager and observe the splash
screen. It tells you that the MOTOROLA

battery is charging to a

minimum level. Charging Battery to Min. Level
THE SPLASH SCREEN %
WILL DISPLAY Pagelyriter-2000X =

IMMEDIATELY OR MAY Copyright @ 12071999, Matorsla, Inc. All Rights Resered.
TAKE A FEW MINUTES,
DEPENDING ON THE CONDITION OF THE BATTERY. As the
battery begins to charge, the Red and Green LEDs on the pager will
briefly flick on. THIS IS NORMAL.

The charging indicator
will move across the
screen from left to right,
until the screen is

process usually takes
about 10 minutes.

Leave your pager in the
charger until the Green LED
on the charger turns on and
the Red LED on the charger ReubuUl:lypcie U THRERERE)
turns off. This will take
another 40-60 minutes but in ter-2000X
the meantime, you can set up _
your pager beginning with
page 18 of théJser Guide YOUR PAGER IS FULLY
FUNCTIONAL EVEN THOUGH THE BATTERY ISN'T FULLY
CHARGED YET.

0

Copyright =1 19971929, Motorala, Inc. AllRights Resened.

After the battery has charged to a minimal level, the Home screen
will display (see page 5).
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MOTOROLA LICENSE AGREEMENT

IMPORTANT-READ CAREFULLY: This license agreement is a legal agreement
between you and Motorola, which includes computer software and associated media and
printed materials, and may include “online” or electronic documentation

(“SOFTWARE”).

By installing, copying or using the SOFTWARE, you agree to be bound by the terms of
this license agreement. If you do not agree with the terms of this license agreement,
promptly return the unused SOFTWARE to the place from which you obtained it for a
full refund.

The copyrights laws and international copyright treaties, as well as other intellectual
property laws and treaties, protect this SOFTWARE.

1. You may install and use one copy of this SOFTWARE on a single computer. The
SOFTWARE may not be used by more than two (2) processors at any one time on the
single computer running the SOFTWARE.

2. You may not reverse engineer, decompile or disassemble the SOFTWARE.

3. The SOFTWARE is licensed as a single product. Its components may not be
separated for use on more than one computer.

4. You may not rent or lease the SOFTWARE.

5. You may transfer your rights under this license, provided you retain no copies, you
transfer all of the SOFTWARE (including all component parts, the media, and printed
materials and this license agreement) and the recipient agrees to the terms of this license.

6. If you fail to comply with the terms of this license, Motorola may terminate this
license agreement, without prejudice to any other rights that Motorola may have. In such
event, you must destroy all copies of the SOFTWARE and all of its component parts.

7. Motorola owns all title and copyrights in and to the SOFTWARE and any copies of
the SOFTWARE. Copyright laws and international treaties protect the SOFTWARE.
However, you may either (1) make one copy of the SOFTWARE for backup or archival
purposes or (2) install the SOFTWARE on a single computer provided that you keep the
original solely for backup or archival purposes. You may not copy the printed materials
accompanying the SOFTWARE.

8. The SOFTWARE and documentation are provided with RESTRICTED RIGHTS.

Use, duplication, or disclosure by the Government is subject to restrictions set forth in
subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer software clause at
DFARS 252.227-7013 or subparagraphs (c)(1) and (c)(2) of the Commercial Computer
Software-Restricted Rights at 48 CFR 52.227-19, as applicable. The manufacturer is
Motorola, Inc., 3301 Quantum Blvd., Boynton Beach, FL 33426-8622.

9. You agree that you will not export or re-export the SOFTWARE to any country,
person, entity or end users subject to U.S. export restrictions. You warrant that your
export privileges have not been suspended, revoked or denied by the U.S. Bureau of
Export Administration or any other federal agency.

10. EXPORT LAW ASSURANCES: You hereby agree to comply fully with the export
regulations of the United States of America. You agree that you will not export the
Software without an export license issued by the U.S. Department of Commerce. You
hereby agree to comply with all regulatory sanctions or restrictions involving a party or
an entity identified as Denied Parties or Specially Designated Nationals by the U.S.
Department of Commerce and/or the U.S. Department of Treasury.
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Welcome

Congratulations! Your new Motorola PageWrité2000X
smart pager is about to change the way you communicate.
With features such as wireless, smart paging and user-
upgradeable system software and applications, your
PageWriter 2000X pager places you in control of your
personal communications. You can how send messages,
control incoming messages, and customize the device with
applications that you select.

This pocket message center features a QWERTY keyboard
and high-resolution graphics display. It enables you to
communicate wirelessly with Internet email addresses, fax
machines, and other pagers, yet is small enough to comfortably
wear on your belt or fit in your pocket.

The PageWriter 2000X smart pager uses FEEperating
System (FLEX OS), Motorola’s hew open-standard operating
system for messaging products, and FI®BXotocol for Two-
Way Paging, Motorola’s high-speed two-way paging
technology.

The built-in suite of software applications includes:

Read— Read incoming messages, including personal, service
bureau, and reminder messages.

Write — Create and send messages to another pager, an email
address, or a fax machine without searching for a phone.
Receive and respond to messages from the same device.

Addresses— Store your personal directory of names, phone
numbers, email addresses, and related information, and
retrieve easily.

Customize— Useset-and-forgefunctions to customize your
preferences such as message text size, unread message alerts
(on/off), and date/time formats.

Set Time— Quickly adjust the time or date to reflect your
movement between time zones or seasonal changes such as
Daylight Savings Time.

Alarm Clock — Set audible or vibrating personal alarms at up
to three different times and frequencies.

Radio Mode — Set your transmission mode to accommodate
your environment. Your PageWriter 2000X smart pager
accommodates the special requirements of hospital or medical
facilities and airline travel.

Welcome 1



Partner — Keep all your records in sync using Motorola’s
FLEX™ PC Partner connectivity software. Update the
Address Book on your computer by transferring your Address
Book files from your PageWriter 2000X smart pager to your
personal computer. Also, changes made to your Address Book
on your computer can be transferred back to your pager.
Finally, everything you need in a smart, customizable paging
devicel! Life just got easier. Consolidate your communications
onto one device — youall-in-one PageWriter 2000X smart
pager from Motorola.

The efficiency and affordability of a pager...

The convenience of full text response.

Using This Manual

Conventions

This manual uses several conventions to differentiate between
command and key access on your PageWriter 2000X smart
pager and your personal computer (PC). Specific conventions
are also used to highlight additional helpful information in the
form of tips, notes, and cautions. Before you begin, please
refer to the following conventions:

On the PageWriter 2000X Smart Pager

Read & Icons represent each application on the
PageWriter 2000X menu wheel.
White buttons identify command
buttons that appear on the screen.
Gray keys identify PageWriter 2000X

keyboard keys.

(ALT), Two keys means to press the first key,
release, then press the second key. Do

not hold down{ALT) or (SHIFT) while

pressing the next key.

Bold Text Bold Text indicates text to select on
the PageWriter 2000X screen or to
type into a field.

2 PageWriteF™ 2000X User's Manual



@ Means to press the NavDist (left,
right, up, down) to movavithin a field
(text field, list field, button field).

Means to pres(TAB) to movebetween
fields(list field to button field).
“Select” Means to highlight a list item,

application icon, or command button,
then pres.‘i.-'.

On the PC

il Icons represent each application in the

Address Book PC Partner Shell.

g Icons represent menu options that can
be selected from the menu bar.

Shadowed keys indicate PC keyboard
keys.

Bold Text Bold text indicates menu options or

command buttons to select or text to
type into a field.

Additional Information

TIP Identifies actions you can perform to
increase your ease of use and efficiency.

Q> Provides further information about the
procedural step or feature.

CAUTION Identifies actions that can cause loss of

data or damage to the product.

Finding Help
We welcome your suggestions on how we can improve our
products and want to hear about any problems you may be
experiencing. To contact us about suggestions or concerns, or
for more information about the PageWriter 2000X smart
pager, its accessories, or other Motorola products, call:

1-800-548-9954
Or, visit our website:
http://www.motorola.com/SmartPagers

How Your PageWriter 2000X Works 3



Getting Started

What's in the Box?
Your new PageWriter 2000X smart pager comes with:
PageWriter 2000X
NiMH Battery
Holster
Charger Base/Docking Station
120 Vac Transformer
RS232 Null Modem Serial Cable
FLEX PC Partner Connectivity Software Disk

e Product Literature (User’'s Manual, Quick Reference
Card, Registration Card)

R N

Paging Service Instructions
To begin paging service, contact your paging service provider
for activation instructions. Your PIN number and the phone
number of the paging service can be found in the literature
provided by the paging service. Use this manual for device-
specific operating instructions.

PageWriter 2000X

}/— Holster

Product Literature —\

Battery Charger "—\ . H“'-H e, /— Battery
of =

F, Irr | ¢

- ;
e
|._|__ o
r ey [
F '} ", -
t 4
el A
R .

& \_ FLEX

l\ RS232 Cable PC Partner Dis k

Transformer
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How Your PageWriter 2000X Works

The PageWriter 2000X smart pager’s lightweight, wearable
design allows you to open the flip and read your messages
while the pager is still in the belt holster. Audio and vibrate
alerts notify you of incoming and waiting messages. The
keyboard provides text entry capabilities that allow you to
send full text messages. All this is combined with the ability to
add applications, upgrade current applications, and, with the
infrared interface in the Motorola Deluxe model, upload and
download information to and from your computer.

TIP The PageWriter 2000X smart pager displays a blank
screen to conserve energy during periods of inactivity.
Press any key to awaken the pager.

The Flip

The front flip on the PageWriter 2000X smart pager houses
and protects its LCD screen and antennae. Opening the flip
awakens the pager, while closing the flip puts the screen into
sleep mode. When in sleep mode, your PageWriter 2000X
smart pager continues to work for you. It receives and stores
incoming messages for access at your convenience. You can
set audible, vibrating, or silent alerts to notify you when
messages are received.

The Home Screen

/7Aoolications

Menu
Wheel

Date & Time —/

Alert
(" Mode

|ﬁddr‘esses E_Q |

Ful] Service

£
Transmission ; 7
Status Status icons

The Home screen’s menu wheel provides quick access to both
pre-loaded applications and those you add yourself. Press the

How Your PageWriter 2000X Works 5
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NavDisd™ =¥ up or down to highlight an application.

FR
Continue pre:ssin';:.r.:-‘I in the same direction and the wheel
spins in that direction to display the next three applications.

TIP To select an application from the menu wheel without
scrolling through the menu, press the first letter of the
application’s name. The menu wheel spins to the first
application beginning with the selected letter. These are
calledshortcuts Shortcuts also work on menu lists such as
your Message Area container list.

If more than one application or more than one list entry
starts with the same letter, the shortcut takes you to the
first occurrence of the letter. Press the letter again and the
shortcut takes you to the next occurrence of the letter.

The Home screen also provides at a glance the basic status of
your PageWriter 2000X smart pager, including:

Date and Time— Always displays the date and time for your
convenience; select the Set Time application from the menu
wheel to change the date or time; select the Customize
application from the menu wheel to change the format for the
date or time.

Alert Mode — Displays the current alert mode. Alert modes
override or enhance the assigned alert types. For more
information, see “Assigning Alert Modes” on page 22. To set
specific alerts, see “Assigning Alert Types” on page 23.

@ Loud — Enables all audible alerts to the loud volume.
Soft — Enables all audible alerts to the soft volume.

changing the individual alert settings.

Silent — Disables the alerts without changing the
settings. Select Loud or Soft to enable the alert settings
at the preferred volume.

@ Vibrate — Enables all alerts to vibrate without

6 PageWritef™ 2000X User's Manual



Battery Gauge— Displays a four-level graphic indicator of
the remaining power in the rechargeable battery.

i Full — Approximately at full charge.
2/3— Approximately at two-thirds capacity.
1/3— Approximately at one-third capacity.
Low Cell — Almost drained of charge.

Status Line— On the menu wheel, displays the in-range/out-
of-range transmission status (Basic Service, Full Service, or
Storing Messages); for more information, see “To set the
transmission mode” on page 20.

On application screens, explains the function of the
highlighted button or special status icon.

Special Status Icons— Displays graphic indicators for the
following conditions:

=1 New Message Waiting— Unread messages are in one
or more inboxes.

"= Send/Receive— Full Service coverage. Two-way
messaging; turns on the transmitter and receiver.

i "= Receive Only— Basic Service coverage. One-way

messaging; turns on only the receiver. Accompanied by
a symbol of a heart with a cross in it, sometimes
referred to as Hospital mode. The unit will never
transmit while in this safe mode for environments with
sensitive equipment (such as CAT Scan and MRI
equipment found in hospitals).

=zl =f= Off — Storing Messages coverage. You have manually

turned off the transmitter and receiver. Accompanied by
an airplane to show this is the safe mode for electronic
devices used in airplanes. See “Configuring Your
PageWriter 2000X” on page 19 for information on
turning the transmitter and receiver back on.

Out of Range— Your pager is too far from a
transmitter to receive messages.

BEfl Memory Low — Available memory is running low;
older messages will be automatically deleted to free
memory for new messages. For more information, see
“Memory Management System” on page 71.

Alt Alt — Alt mode is turned on; the next key pressed will
indicate an Alt-mode function. For more information,
see “Alt Functions” on page 10.

¥
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chit Shift — Shift mode is turned on; the next letter will be
capitalized, or the next control key pressed will indicate
a Shift-mode function. For more information, see
“Shift-mode Functions” on page 11.

CAPE Caps Lock— Caps Lock setting is turned on; all letters
will be capitalized.

The Keyboard

3%V ®
0]01010108]010101010

Backlight/
Contrast

Select

Back

NavDisc

The PageWriter 2000X smart pager comes with a QWERTY
keyboard. Special control keys and key combinations provide
the following functions.

Standard Control Keys
NavDisc— Moves the cursowithin a field (i.e., text
field, list field, button field). Press the outside edge of

to move the cursor in that direction. In a text field,
moves the cursor between characters. In a button field,
scrolls the cursor between command options.

8  PageWritef™ 2000X User's Manual



Compose Hessoage

Roh-—
will bhe bock Friday for
Text Field — |your 2 P eet ing.
Cotheri
Button Field Cursor
o
[Send To ||File It ]L[:_um::el’ ]L‘})
Enter text then Send To | =

Additional O ptions

Tab — Moves the cursobetweerfields (e.g., text field to
button field). From the text field, pre{JaB) to access the
button field. Continue pressinTag) to cycle back to your

initial starting point, or pres(atr) , to tab backward.

.fi?-, Back — Cancels input for the current screen and goes back

. . e .
to previous screen. Continue press‘-i.,J and resolving to
return to Home Screen.

.-"}‘“. Select— Selects a highlighted item from a list or activates
the button highlighted by the cursor. Highlight the list item

e
or button, then predi= to select.

Hessoge Aren |
ilbhox Messoages

List Item

Highlighted  Troashocoan
List item

| Owen |[Cleanup || Exit ][
[ F=
Home — Returns to the menu wheel (Home) screen.

Backspace—When the cursor is positioned in text, it
deletes the character preceding the cursor.
Space— Inserts a space in text.
Enter — Inserts a paragraph return in text.
AlT)  Alt — Activates the Alt-mode control keys, which are
color-coded blue on the keyboard. Pr(aLT), then

release. The status ic&lt appears on the screen. The
next key pressed will indicate the Alt-mode function.

How Your PageWriter 2000X Works
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Do not hold dowrfaLs) while pressing the next key.

Alt mode turns off wher(aLT) is pressed again or when a
key other than an Alt-mode key is pressed.

Shift — Activates the Shift-mode control keys. Press
then release. The status icshft appears on the
screen. The next letter pressed will be capitalized, or the
next control key pressed will indicate a Shift-mode
function. Shift-mode characters are color-coded white on
the keyboard near the corresponding control key. Three
other keys @) (7] (7)) provide Shift-mode access to
three more symbols/(’ -). Do not hold dowr{SHIFT)
while pressing the next key.

Shift mode turns off whe(SHIFT) is pressed again or
when a key other than a Shift-mode key is pressed.

Backlight — llluminates the screen and the keyboard.
The backlight remains on until the display times out, the
flip is closed, or you presig again.

Alt Functions

Thirteen symbols (coloreblue on the keyboard) are available
using the Alt mode. The number keys plus three other keys

(@))12)) are used by pressifaLt), then the corresponding
key.

1|t 2 3| = |a 5 <|e|> |7/l

sl] lolf lol} 121\ |, 1

Alt-mode Functions

+ Contrast — Adjusts the contrast; the difference between
the lightest and darkest areas on the display. FaLT}s
then hold dowrfg. The contrast value will progress to
extreme light or dark, then reverse. Relefgjevhen you
see the desired contrast setting.

(ALT), Off — Turns off the pager. When the pager is off, press
any key to turn it back on.

(ALT), Caps Lock— Activates Caps Lock. Each letter pressed is
capitalized unti(att), is pressed again.

(ALT), Symbols— Activates the Symbols key. Fifteen (15)
additional symbols can be used. PraLT), to view

the Symbols screen, then press the key that corresponds to
the symbol you want to add to your message. The original
screen reappears with the symbol added to your text.

10 PageWritef™ 2000X User’s Manual



Most of the symbols are also available on the keyboard
using the Alt mode.

1 |t =13 |~la|<]|s5 |>

6 1M 17 1&1s " 1o l; lo |\

a [ b ] c { d } e |

(ALT), BackTab — Reverses the direction for one key
press.

@ Page Up/Page Down— Activates Page Up and Page
Down and disables Page Right and Left for one key press.

In the Message Area, press@ I:.v.:']move to the top or
bottom of the list.

Shift-mode Functions

Thirteen symbols (coloredhite on the keyboard) are
available using the Shift mode. The number keys plus three

other keys @) (7] () ) are used by pressirfHIFT), then the
corresponding key.

1V 2| @3 |# 4S5 W67 &
s|* Lol Clol) [0/, [" |. |-

The Battery and Charger

Motorola batteries and chargers are made from the highest-
quality materials available. The battery and charger included
with the PageWriter 2000X smart pager come with a one year
warranty and should provide good performance well beyond
the initial warranty period. However, rechargeable batteries do
not last forever. At some point, batteries wear out and must be
replaced. If your battery’s performance has degraded (e.g., the
battery’s charge lasts only half as long as when it was new),
you should consider replacing your battery with a new
Motorola factory-assured battery. Batteries, as well as any
other Motorola PageWriter 2000X accessory, can be
purchased through your dealer, or by calling Motorola direct at
1-800-548-9954.

TIP Before leaving on a trip, make sure the battery and any
extra batteries are fully charged. All rechargeable batteries
experienceself-dischargemeaning that a small amount of
energy discharges everyday as a battery sits on the shelf.

How Your PageWriter 2000X Works 11



Recharging the batteries to full charge should take an hour
or less per battery.

Recharging can be accomplished by placing your
PageWriter 2000X smart pager in the charger or by
removing the battery and placing only the battery in the
charger. For optimum performance, use the recommended
Motorola charger.

To remove the battery for charging:
1. Hold the pager face down.

2. Place your thumb on the arrow in the center of the battery
door. Press down and slide the battery door away from the
center of the pager.

4. Using the white lift tab, lift the battery from the battery
compartment.

12 PageWriteF™ 2000X User's Manual



To
1.

TIP

recharge the battery outside of the pager:

Insert the transformer’s round connector into the back of
the charger.

Transformer
Two-pronged Plug

Battery
Compartment

Transformer
Round Connector

Insert the transformer’s two-pronged plug into any
standard 120 Vac power supply outlet.

Place the 3.6 V NiMH battery in the charger’s battery
compartment by aligning the positive (+) and negative (-)
markings on the battery with those on the charger.
Press the battery firmly into place. The lit red LED
indicator light means that the battery is charging.

A flashing red LED indicator means the battery is not
making a good contact. Ensure the battery is properly
seated in the charger.

When the green LED indicator becomes lit, the battery is
fully charged. Slide your finger or thumb underneath the
battery from the front of the charger and lift the battery
out.

Leaving the battery in the charger after the LED turns
green keeps the battery fully charged until removed. Keep
your spare battery fully charged by leaving it in your
plugged-in charger.

Remove the round transformer connector from the back of
the charger, then remove the two-pronged transformer
plug from the power supply.

How Your PageWriter 2000X Works 13



To replace the battery:

1. Match the positive (+) marking on the fresh battery with
the two (2) contact side of the pager’s battery
compartment and the negative (-) marking with the one (1)
contact side of the battery compartment.

2. Insert the battery into the battery compartment at an angle
toward the outer edge of the pager, then press the battery
down into place.

N

N2 P

t%:> Ensure the lift tab is underneath, not on top of, the battery.
The tab is designed to help lift the battery out of the
compartment during battery removal.

3. Fold the protruding lift tab down on top of the battery,
then slide the battery door back into place. An audible
click can be heard when the door is securely closed

To recharge the battery without removing it from

the pager:

1. Insert the transformer’s round connector into the
connector on the back of the charger.
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Transformer
Two-pronged Plug

Transformer
Round Connector

2. Insert the transformer’s two-pronged plug into any
standard 120 Vac power supply outlet.

3. Hold the pager face up over the charger.

4. Position the pager with the Motorola logo on the same
side as the charger’s red and green LED indicators.

t%:> The battery can be charged separately or while it is in the
pager. The charger is intentionally designed so that you
cannot place both the extra battery and the pager in the
charger at the same time.

Indicators

5. Press the pager down into the charger until an audible
click is heard. The red LED indicator light means the

battery is charging.
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t%:> A flashing red LED indicator means the battery is not
making a good contact. Ensure the pager is properly
seated in the charger.

6. When the green LED indicator lights, the battery is fully
charged. Slide the pager forward to release it from the
charger.

7. Remove the round transformer connector from the back of
the charger, then remove the plug from the power supply.

The Infrared Port

The PageWriter 2000X includes an infrared (IR) port in the
charger housing. This device is used aaking statiorfor

your pager when transferring data to and from your computer.
The IR port in the docking station aligns with the IR port on
your PageWriter 2000X smart pager, enabling data
transmission. The docking station is connected to your
computer with the Motorola-provided RS232 null modem
cable.

When a data transfer is in process between the PageWriter
2000X and a PC, the green and red LED indicator lights will
flash intermittently.

To connect the docking station to your computer:

1. Connectone end of the RS232 cable to your computer’s
nine-pin serial port.

2. Connect the other end of the RS232 cable to the nine-pin
connector in the back of the docking station.
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RS232 Cable

3. Insert the transformer’s round connector into the back of
the charger.

4. Insert the transformer’s two-pronged plug into the power
supply.

5. Snap your PageWriter 2000X smart pager into the
charger. You are now ready to access the FLEX PC
Partner application from your PageWriter 2000X smart
pager's Home menu wheel. See “FLEX PC Partner” on
page 51 for more information on using the FLEX PC
Partner application.

The Holster

The durable, clip-on holster allows you to comfortably wear
your PageWriter 2000X smart pager on your belt or pocket.
Additional accessories are also available. For more
information, call 1-800-548-9954.
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System Setup

Your PageWriter 2000X comes pre-configured and ready for
use. Features are available that allow you to re-configure your
pager to more closely reflect your lifestyle, set the date and
time, and select the alert modes and types. For information on
customizing other features, see “Customize” on page 43.

Turning On and Off Your PagerWriter 2000X

The rechargeable battery in your PageWriter 2000X allows
you to leave your pager turned on 24 hours a day and,
depending upon usage, can sustain operation for
approximately a week before requiring a recharge. However,
your PageWriter 2000X works much like your computer.
Periodically turning off your pager assists in clearing the
random-access memory (RAM) and can help optimize your
pager’s performance. Turning off your pager at night will also
lengthen the time of your battery’s charge.

TIP Incoming messages are stored by the paging service until
your pager is turned back on and ready to receive
messages. Turn your pager off at night when you do not
want to receive messages, and place the pager in the
plugged-in charger so it will be fully charged and ready
for use in the morning.

To turn on your pager:
Press any key.

To turn off your pager:

Pres<@l) , (OB,

_Or_

P OFf I
Selecq " from the menu wheel.

To reset your pager:

Turn off your pager as indicated in the previous procedure,
then press any key to turn the pager back on.

_Or-
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1. Hold the pager face down.

2. Place your thumb on the arrow in the center of the battery
door. Press down and slide the battery door away from the
center of the pager.

Reset Button

Lift Tab

4. Using a pen or other small pointed object, press the reset
button.

5. Fold the protruding lift tab down on top of the battery,
then slide the battery door back into place. An audible
click can be heard when the door is securely closed.

Configuring Your PageWriter 2000X

Before attempting to send or receive messages, ensure your
pager is set to the proper transmission mode. You can also
adjust the message text size or turn on or off the audible
keyboard clicks when preparing your pager for use.
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To set the transmission mode:

. (%“l
1. Selec|Radioflode (\ﬂ from the menu wheel.

2. Select the transmission mode:

= Send/Receivé] Full Service coverage. Turns on
the receiver and transmitter for two-way message
transmission. Messages can be sent and received
from your pager.

& F= Receive Onlyll Basic Service coverage. Turns on
only the receiver for one-way message
transmission. Messages can be received but not
sent from your pager.

=== Off O Storing Messages. Turns off the transmitter
and receiver. Messages cannot be sent or received.

TIP & F+Sometimes referred to as Hospital mode. The unit
will never transmit while in this safe mode for
environments with sensitive equipment such as CAT Scan
and MRI equipment found in hospitals.

== ZHOff is recommended for airline travel. Radio
transmissions can interfere with flight navigation and
communications. Follow FAA regulations. Turn off the
transmitter while on airplanes.

Selec{_Dene ] to return to the main screen.

t%:> When the pager is in Off mode, messages are retained by
the paging service until you change modes (Send/Receive
or Receive Only).

w

TIP Off mode does not turn off your pager. It turns off the
radio frequency (RF) transmission. You can still use the
applications on your pager to update your Address Book,
schedule reminders to yourself, or compose messages to
be sent at a later time.

TIP When moving to another zone, reset your pager back to
Full Service Send/Receive mode until you receive your
first page, then you can put the pager back into Receive
Only mode. This allows you to tell the service provider
where to find your pager. Zones are defined by the paging
service provider, but in general, a major metropolitan area
counts as a zone (e.g., the greater Chicago area
is one zone).
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To change the message text size:

1. Selec|{tustonize @% from the menu wheel.
FE,

2. Prestu’ up or down to highlighiMessage Text

&)
then pres®=- to toggle between:

[Now NORMAL] O Displays message text in the
standard font size.

[Now LARGE] O Displays message text in a larger font
size.

3. PresqTaB) to access the button field, then sel__Done |

to accept the changes and return to the menu wheel.

To turn on/off the audible keyboard click:

1. Selec|{tustonize % from the menu wheel.
FE,

2. E‘ESSiU up or down to highlighKey Clicks, then press
o toggle betweefNow ON] and[Now OFF].

3. PresqTaB) to access the button field, then sel_Done |

to accept the changes and return to the menu wheel.

Setting the Date and Time

Although your new PageWriter 2000X smart pager comes pre-
configured, you might need to set the correct date and time
when you first receive your pager. Through the Set Time
application, you can also reset the date and time to reflect your
movement between time zones and for seasonal changes, such
as Daylight Savings Time.

To set the date/time:

Set Ti
1. Selec{™* ''™ ® from the menu wheel.
R

2. From the Time field, pres'*:eq.:-:I up or down in each field
Pl

T
to change the hour, minute, or AM/PM. Préve” right or
left to move between Time fields.

P

3. Presq{TaB) to access the Date field, then prie" up or

FR
down to change the numbers for the date. P'fq.r.f-’;right
or left to move between Date fields.
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4. Pres{TaB) to access the button field, then sel ok |

to accept the changes and return to the menu wheel.

To select the date format:

1. Selec|{tustonize % from the menu wheel.
FE,

2. Presta’ up or down to highlighDate Format,

then pres.‘,@' to cycle between:

[Now DD/MM/YY] O Displays day/month/year format.
[Now YY/MM/DD] 0O Displays year/month/day format.
[Now MM/DD/YY] O Displays month/day/year format.

3. PresqTaB) to access the button field, then sel__Done |

to accept the changes and return to the menu wheel.

To select the time format:

1. Selec|{tustonize @% from the menu wheel.
FE,

2. Prestu’ up or down to highlighfime Format,

&)
then pres®=- to toggle betweefNow AM/PM] and
[Now 24 hr].

3. PresqTAB) to access the button field, then sel_Done ]

to accept the changes and return to the menu wheel.

Assigning Alert Modes

Four alert modes are available from the Home screen that
quickly and easily override the alerts without changing the
settings. They include Loud, Soft, Vibrate, and Silent. The
alert modes allow you to increase the volume of the alert when
you are in a noisy environment, decrease the volume for
normal environments, substitute vibration when no sound is
desired, and turn off the alerts for environments where any
alert is inappropriate.

To select an alert mode:
P
1. From the Home screen, pre“s” to the right to OfTAB)
highlight the alert mode icon.

&) -
2. Pres#&E"to cycle to the desired alert mode.

22 PageWriteF™ 2000X User's Manual



P
3. Press“s" or(TAB) to exit the alert mode icon and accept
the change.

Assigning Alert Types

Different alert types can be assigned to the inboxes that
receive your messages. This allows you to identify by sound
the type of message you are receiving. An alert type can be set
for each of the alert modes. If an audible alert mode (Loud or
Soft) is selected from the Home screen, the alert you assigned
on the Set Alert Screen will notify you of incoming messages.

To select an alert type:

1. Selec{®e™ & from the menu wheel.
F
2. Preséa’ up or down to highlight the inbox for which

you are assigning an alert type, then se{ Custmize |.
Selec{Next—#] to bypass the Edit Inbox screen.

P
4. Presea leftor right to scroll through the alert options.
PresgJaB) to move between alert mode fields.

TIP PresdENTER) to sample the alert.

5. Selec{_Done ]to accept the changes and return to the
Message Area screen.

w

Addresses

The PageWriter 2000X smart pager contains an address book
for storing the address information of each person or group

you might want to contact. You can include the type of pager

and its PIN, an email address, a fax number, home and work
phone numbers, and even miscellaneous notes for each address
entry. When viewing address entries, the status bar notifies you
if there is additional information not displayed on the screen.

F
TIP To view the additional data, press Pri=" down to
scroll through the rest of the information.
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When you are ready to send a message, each person or group
will have an address entry for each type of address you have
identified, such as two-way pager or email.

té{> The amount of entries in the Address Book is only limited
by the amount of free memory available (see “Viewing
System Status” on page 43 and “Checking Memory Usage
on Your PageWriter 2000X” on page 70).

té{> Group names are indicated in the list of Address Book
Entries with the label GROUP.

té{> Up to 25 members can be added to each group.

Entering Addresses

The Address Book contains addresses for individuals as well
as for groups of individuals. Group addresses allow you to
compose and send one message which is transmitted to each
member of the group.

TIP You can force address names to appear in a position in the
Address Book that you find convenient. For example,
prefacing group names with a space forces all the groups
to appear at the top of the list. Using an underscore
instead forces the names to the bottom of the list.

To add an individual:

1. Selec|Pddresses from the menu wheel.
2. SeleciNew Individual Entry .

3. Inthe Name field, type the name for the entry as it should
appear in the Address Book (e.g., Cody, Catherine).

t%:> The Address Book sorts address entries alphabetically
based on the first letter in the address name. Type the last
name first if you want to find addresses for individuals by
their last name.

F
4. Inthe Carrier field, pres":.r;'i left or right to scroll
through the paging service providers. Highlight the name
of your carrier, then pre§TAg) to move to the next field.

t¥:> If the paging carrier of the addressee is accessible from
your paging carrief=] appears next to the Pager field.
If the envelope does not appear, the Enter PIN field
allows you to store the pager information
for reference only.
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F
5. Inthe Pager field, pre:'*:.r;'i left or right to scroll through
the pager types. Highlight the pager type, then
to move to the next field.

Enter the individual’'s PIN and/or fax number.

o

té{> provides access to additional information about the
PIN for the selected pager type.

7. Selec{Next—®|, to access a supplemental screen where
you can enter other address information, such as email
address, home phone number, work phone number, and
fax number.

8. Selec{Next—#], then type any additional information in
the Notes text field.

9. Selec( Done ]to return to the Address Book Entries
screen.

To add a group:

Selec| fddresses from the menu wheel.
SeleciNew Group Entry.

3. Inthe Name field, type the name for the group as it should
appear in the Address Book (e.g., Sales Team), then select

4. Select the individuals to add to the group.

P

TIP Pressis’ L.-J*Pxor down to highlight an address entry,
then pres.‘i.-' to select the entry? appears next to each

o
entry selected. Preie again to de-select an entry, as
required. When you are finished selecting group members,
presgTaB) to access the button field.

5. Selec{ 0K ]to accept the changes and return to the
Address Book Entries screen.

Editing Addresses

Addresses saved in your Address Book can be updated as
information changes. To update Address Book files from your
personal computer (PC), review “FLEX PC Partner” starting
on page 51, then see “Managing Your Address Book” on
page 58.
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TIP Type as many characters of the address name as you want
to easily find the contact you are looking for. If the
address cannot be found, the pager will beep and display
an error message.

To edit an individual address:

1. Selec|{Mddresses from the menu wheel.
FE,

2. Prestu’ up or down to highlight the address entry
requiring change then, seld__Edit .

3. Place the cursor in the field containing the information
you want to change.
In text fields, pres{BKSP) to delete old information, then
type the new information.

_Or_

F
In scrolling fields, pre:s'*:.r;'i left or right to scroll within
the fields and highlight the correct information.

4. Selec{_Done ]to return to the Address Book Entries
screen.

To change the name of a group:

Add
1. Selec{™@res=es from the menu wheel.
FE,

2. Prestu up or down to highlight the name of the group
you want to change.

3. From the group addresses screen, s(EditName .
4. From the Change Group Name screen, pBKSP) to
delete the current name, then type the new name.

5. Selec{ ok __]to accept the change and return to the
group addresses screen.

To change the group’s membership:

1. Selec|Pddresses from the menu wheel.
F
2. Prestu up or down to highlight the name of the group
to which you are adding or deleting members, then select
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3.

TIP

TIP

From the group addresses screen, select the entries from
the Address Book to add to or remove from the group’s
membership.

P

Prescue up or down to highlight an address entry,
™
then pres.‘i.-' to select the entryv appears next to each

B oo
entry selected. Pre =Y again to de-select an entry, as
required. When you have finished selecting group
members, preqTAB) to access the button field.

Remember! Deleting a member from a group will not
delete the individual member’s address from the Address
Book. After deleting a member from a group address,
delete the individual address, as needed.

Selec{ ok ]to accept the changes and return to the
Address Book Entries screen.

Deleting Addresses

A well maintained Address Book provides quick access to the
addresses you need. Delete addresses for individuals that you
no longer contact or for groups that no longer exist.

TIP

G

Remember! Deleting group addresses will not delete the
individual member addresses. After deleting a group
address, delete the individual addresses, as needed.

The deletion of addresses cannot be undone.

To delete an address:

1.

2.

3.

Add
Selec] """ from the menu wheel.
FE,

Preseu up or down to highlight the Address Book

entry, the seled_Delete |.
Selec{_ves ] at the confirmation screen to delete the
address and return to the Address Book Entries screen.
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ﬁ Write

The Write application enables you to compose messages using
the QWERTY keyboard, insert Quick Text, and append your
signature. You can also choose to send your messages at a
later time, file the messages in inboxes prior to sending, and
even place reminder alerts on messages. When you send a new
message, you return to the Home screen and the status of the
message is displayed there. Messages can be sent to other
smart pagers, two-way pagers, one-way pagers, email
addresses, and fax numbers by selecting the appropriate
address. See “Entering Addresses” on page 24 for more
information on creating address entries.

Writing Messages

The QWERTY keyboard provides a familiar key layout,
enabling you to quickly type and send your message. For
information on Alt-mode keys and Symbols, see “Alt
Functions” on page 10.

Thirteen symbols (coloreblueon the keyboard) are available
using the Alt mode. The number keys plus three other keys

(@ () () are used by pressiraL), then the corresponding
key.

sl] lol{ lol} l2l\ |, |5 | . |:
For information on Shift-mode keys, see “Shift-mode
Functions” on page 11.

Thirteen symbols (coloredhite on the keyboard) are
available using the Shift mode. The number keys plus three

other keys @) () () ) are used by pressifgHIFT), then the

corresponding key.

1!2@3#4$5%6A7&
s | * (ol Clo]) |20/ 1" L. |-

To write a message:

1|+ ]2 3= lal" |sl<|e|>]|7]I

1. Selec{V"'t® z from the menu wheel.
2. Type your message, then pr(TaB) to access the button
field.
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TIP

TIP

TIP

TIP

5.

Importing

Selec{Send To .

Select the recipient(s) from the Address Book list.

Each recipient can have more than one entry. Select the
recipient by the type of messaging device receiving the
message (e.g., smart pager, two-way pager, one-way
pager, email, fax).

Before sending messages to fax addresses, use the
Customize application to record the Internet email address

for your Internet fax service.
FR

When selecting an entry, pre":.r.:-‘I up or down to
highlight an address entry, then pr«'i.-' to select the

(o
entry.¥ appears next to each entry selected. P==05
again to de-select an entry, as required. When you have
finished selecting recipients for your message,

to access the button field.

F
Presd! from the Address Book list to return to the
message and continue editing.

Selec{_Send ]to send your message.

Messages

The Import feature enables you to use text from a message
stored in one of your inboxes, as part of an outgoing message.

To
1.

import a message:

From the Compose Message screen, Sw@%
view the list of mailboxes.

Open the desired mailbox.

Open the existing message you want to use as the basis for
your outgoing message.

Edit as necessary.

Send as you normally would: pre{Ag) (Send To] select
the recipient of the message and then, s{_Send .

Adding Quick Text

The Quick Text feature enables you to quickly add frequently
used text to your messages. This saves time and key strokes
when composing a message. See “Customizing Message
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Features” on page 47 for information on composing your own
Quick Text through the Customize application.

To add Quick Text to your message:
6. From the Compose Message screen, s.

F
7. Prestu L.-J*Pxor down to highlight the desired text,
then pres.‘,i.-'. The Quick Text appears in your message
on the Compose Message screen, ready for you to
complete your message.

Attaching Message Replies

When sending a message to a two-way pager that returns
canned text responses, your PageWriter 2000X smart pager
allows you to provide a selection of replies to your message.
Messages typed in the Replies fields will be available to the
person receiving your message. Rather than selecting the
canned messages available on their pager, they can select one
of the customized replies you have provided.

To attach Replies to your message:
1. From the Compose Message screen, s[_Replies |.
2. Type your choices of replies in the numbered fields.

Y Fields are provided for sixteen replies. and
to access the additional fields.

3. Selec{ Auach | to attach the replies to your message when
it transmits.

Saving Your Message to the Drafts Inbox

If a message comes in while composing a new message, you

can save the message to the Drafts inbox and display the

incoming message.

To save the current message to the Drafts inbox while

receiving an incoming message:

1. Fromthe Compose Message screen, answer Yes to exit
screen and read it now.

2. Answer Yes to save current message to Drafts inbox and
view incoming message.
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Scheduling a Delayed Send

Messages can be composed at your convenience and then
scheduled for automatic transmission later at the appropriate
send time.

To schedule the transmission of a message:

1. From the Compose Message screen, s(Send To .
Select the recipient(s) from the Address Book list.

2.

3. Selec(_Delay ].

4. From the Time field, select the time when you want to
F

send the message. Priv up or down in each field to
FR

change the hour, minute, or AM/PM. Preagy right or
left to move between Time fields.

5. PresqJaB) to access the Date field. Select the date when

FR
you want to send the message. Pl'h.r.:’ up or down to

change the numbers for the date. Pl'h.r.:’ right or left to
move between Date fields.

6. Selec{ ok __]to accept the schedule.

Filing a Message Dratft

Partial or unfinished messages can be stored for later edit
and/or transmission. Saving your messages to an inbox avoids
unnecessary text re-entry while allowing you to compose
messages at your convenience.

Similarly, partial or unfinished messages can be saved in the
Drafts inbox when an incoming message interrupts you. When
a message in the Drafts inbox is opened, the Write application
is launched (see “Saving Your Message to the Drafts Inbox”
page 30).

To file the draft of a message before transmission:
1. From the Compose Message screen, s|_File It_].

P

2. Prestu up or down to highlight the inbox to which you

want to save your message draft, then s¢__File _J.

Your draft is saved to the inbox for edit or transmission at
a later time.
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Entering a One-Time Address

Occasionally, you may send a one-time e-mail message from your
pager. For example, you want to send a demonstration e-mail message,
but you’ll never have a reason to send e-mail to this individual again. In
such a situation, you don’t want savethe individual’s e-mail address,
since it will only take up space on your pager.

To set a one-time address:

1. Atthe menu wheel, seld ¥"'*® g , just as you
ordinarily would to send a message.

2. Atthe Compose Message screen, enter the text of the e-
mail message in the usual manner.

3. Selec{send To].

4. Atthe Choose Recipients screen, select New Address (it
should be already highlighted).

5. Atthe New Address screen, prqTas) to go directly to
the Address Type fieldeaving the Name field blank
This tells your pager not to save the information in the
Address Book.

F
6. Pressw left or right to select E-mail Address. Press
to move to the E-mail Address field.

7. Enter the individual's e-mail address just as you normally
would.

8. Selec{ ok ] Note that at the Choose Recipients
screen, the last item is the e-mail address you just entered,
and it has a check mark next to it.

9. Selec( Send ]. The e-mail message will be transmitted,
but nothing will be saved to your recipient list.

ﬁ Read

The Read application enables you to read and respond to
incoming messages, forward or file messages, and delete
messages. It also allows you to manage the inboxes, folders,
Outbox, and Trashcan accessible from the Message Area.

Reading Incoming Messages

Incoming messages can be read as they are received or held in
the appropriate inbox to be read at a later time. The New
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Messages screen takes you directly to the new message, or you
can access unread messages from the Message Area screen.

To read an incoming message:

Selec{_ves | at the New Messages announcement screen to
display the message.

TIP The top of the Message screen displays the quantity of

new messages waiting to be read (e.g., Message 1 of 4).
F

Presc«e" down or up to scroll within the message text.

F
Preseie: right or left to scroll between the messages.

té{> Messages that have already been read cannot be accessed
from this list of new messages. Use the Read application
to view previously read messages. See the next procedure
for viewing messages from the Message Area screen.

To read a message from the Message Area screen:

1. Selec "™ & from the menu wheel.
Select the inbox containing the message.

N

t%:> Ml indicates an inbox containing at least one unread
message.
M indicates an inbox that contains only messages that
have already been read.

Select the message.

w

t4{> =1 indicates a new, unread message.
B indicates that you have already read the message.
2 indicates messages with alarms.

4. Selec{_Done ]to return to the Messages list, or press
to return to the menu wheel.

Setting a Reminder Message Alarm

Send yourself a reminder for meetings, special events, and
other important To Do’s. Reminder messages can be sent once
or on a regular basis (e.g., daily, weekly, monthly, yearly).
When it's important that you remember, send yourself a
reminder message on your PageWriter 2000X smart pager.
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To set a reminder message alarm:

SelecVr'te z from the menu wheel.
Type your reminder message, then se_File It_|.
P

Preseu up or down to highlight the folder to which you
want to save your reminder message, then s{_Alam_|.
From the Time field, select the time when you want the

FR
alarm to remind you. Predie’ up or down in each field
FR

to change the hour, minute, or AM/PM. Proage right or
left to move between Time fields.

Pres{TaB) to access the Date field. Select the date when

P

you want the alarm to remind you. Preve up or
FR

down to change the numbers for the date. P'fq.r.f-’;right

or left to move between Date fields.
FE,

Pres{TAB) to access the alert frequency field. Prie’
up or down to highlight how often you want this message

to remind you, then prefi.-'.

Pres{TAB) to access the button field, then sel__ok ]

to accept the schedule.

Selec{__File ] At the scheduled time, your reminder
message is sent to you.

Sending Responses

Responding to messages is quick using pager-provided
(canned) text or the QWERTY keyboard.

To send a custom reply:

1.

From the Message screen, se(_Reply_]. The Custom
response is highlighted at the top of list.

F
Pres¢®) and write your reply(TaB) to send and press

&
#0 to send your response.

To send a canned reply:

1.
2.

From the Message screen, se(_Reply |.

Highlight one of the provided responses from the list.
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3. Selec{ send ]to confirm that you want to send the
desired response.

Forwarding Messages

Your PageWriter 2000X smart pager enables you to share your
received messages without retyping them. Simply forward the
message to an address in your Address Book. Your signature is
appended to the beginning of the forwarded message.

To forward a message:

1. From the Message screen, se|Fwd. To |.

£
TIP Pres{TAB) to access the button field, th*=" to scroll
through the options.

2. Type aforwarding note if desired, then se(Send Ta .
3. From the Choose Recipients screen, select the recipient(s),

then seledSend .

£

TIP When selecting an entry, pre":eq-:-‘I U[Z:fg{ down to
highlight an address entry, then prf,i.-' to select the

(o
entry.¥ appears next to each entry selected. P==25
again to de-select an entry, as required. When you have
finished selecting recipients for your message,

to access the button field.

4. Selec{ Done |to return to the Messages list, or press
to return to the menu wheel.

Filing Messages
Messages that have been read can be saved to an inbox. For
more information on creating inboxes, see “Inboxes” on
page 36.

To save a message to an inbox:

1. From the Message screen, se[_Filelt_].
£
TIP PresqTAB) to access the button field, th'=" to scroll
through the options.
P
2. Prestu up or down to highlight the inbox to which you
want to save your message, then s¢__ oK.
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3. Selec{ Done ]to return to the Messages list, or press
to return to the menu wheel.

Deleting Messages

Messages can be deleted from either the Messages list or the
Message screen. Deleted messages are moved to the Trashcan,
where they are permanently erased when the Trashcan is
emptied. For more information, see “Trashcan” on page 43.

To delete a message from the Messages list:

From the Messages list, pre'*q.r.:jl up or down to highlight the
message you want to delete, then s¢_Delete |. The message
is deleted.

To delete a message from the open Message

screen:
From the Message screen, se(_Delete |. The message is
deleted.

Managing the Message Area
The Message Area contains three types of containers:
M Inboxes
1 Outbox
ff Trashcan

Inboxes

Inboxes are containers that receive incoming messages
transmitted to your PageWriter 2000X smart pager. Three
types of inboxes automatically organize the messages for you:
Main Inbox, information services, and personal.

The Main Inbox receives general messages that are sent to
your pager. You can set message alerts and assign a cleanup
schedule to help maintain the contents, however, the Main
Inbox cannot be renamed, have routing rules assigned, nor be
deleted.

t%:> Routing rules are specific keywords or text strings that
your PageWriter 2000X smart pager looks for in incoming
messages. You can identify keywords or text strings for
personal inboxes. When keywords or text strings are
found, the message is placed in the appropriate inbox.
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Information services inboxes receive subscriber messages,
such as world news, financial updates, and sports scores.
Information services inboxes can only be created, renamed, or
deleted by the information service provider. Changing
information service inboxes requires a software change that is
completed over-the-air (OTA) or at a service center by the
service provider.

Personal inboxes are inboxes that you can create to receive
specific types of messages. Incoming messages are
automatically routed to your personal inboxes based upon the
routing rules you assigned for each inbox. The number of
incoming messages is reported when you view the inbox. You
can create, rename, or delete personal inboxes at any time.

To create a personal inbox:

1. Selec(Red [ from the menu wheel.
£
TIP PresqTAB) to access the button field, th'=" to scroll
through the options.

2. Selec(New Inbox].

3. Type the name of the new inbox in the name field.

4. Type specific keywords ibet messages wifield that
your pager will look for in incoming messages. Messages
containing one or more of these strings will automatically
be placed in this inbox.

5. Selec{_Done ]to accept the changes and return to the
Message Area screen.

-Or-
Selec{Next—®| to continue configuring the new inbox.
F
6. Prestwe left or right in each alert mode field to select
the alerts.

TIP PresqENTER) to sample the alert.

7. Selec{_Done ]to accept the changes and return to the
Message Area screen.

-or-
Seleci{Next=—#| to continue configuring the inbox.
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10.

Select the cleanup option:
No Cleanupd Keeps all messages.

Number of Messages$] Keeps the most recent messages
up to the number of messages indicated.

Age of Message§] Keeps the messages that have been
in the inbox fewer days than the number of days indicated.

If the automatic cleanup is selected, type the maximum
number of days the message is retained in the inbox
before it is deleted, or the maximum number of messages
retained before the oldest message is deleted.

Cleanup runs nightly deleting only read messages and
those without alarms.

Selec[ Done |to accept the changes and return to the
Message Area screen.

To rename a personal inbox:

1.

2.

Select Re [ from the menu wheel.

F
Pressie up or down to highlight the inbox you want to
rename, then sele( Custmize |.
Pres{BKSP) to delete the current name, then type the new
name.

Selec{_Dene ] to accept the changes and return to the
Message Area screen.

To assign routing rules:

1.

2.

»

Read
Selec| ™" & from the menu wheel.
FE,

Preseu up or down to highlight the inbox requiring
routing rules, then sele( Custmize J.

Type specific keywords iGet messages wifield that

your pager will look for in incoming messages. Messages
containing one or more of these text strings will
automatically be placed in this inbox.

Do not use the same text for more than one inbox.

Selec{_Dene ]to accept the changes and return to the
Message Area screen.
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To set the alert type for an inbox:

1. Selec{®e" & from the menu wheel.
FE,

2. Preséa’ up or down to highlight the inbox requiring a

new alert type, then sele] Custmize |.
3. Selec{Next=—k| from the Edit Inbox screen.

F
4. Pressus leftor right in each alert mode field to select
the alerts.

TIP PresdENTER) to sample the alert.

5. Selec{ Done ]to accept the changes and return to the
Message Area screen.

To clean up an inbox:

1. Selec "™ & from the menu wheel.
FE
2. Prestu’ up or down to highlight the inbox you want to
clean up and pre{TaB).

Selec{ Cleanup J.

3
té{> Cleanup deletes only read messages and those without
alarms.

To assign a cleanup schedule to an inbox:

1. Selec{®e" & from the menu wheel.
FE,

2. Prestu’ up or down to highlight the inbox requiring a

cleanup schedule, then sel{ Custmize |.
3. Selec{Next=—w| from the Edit Inbox screen.
4. Selec{next—+] from the Set Alerts screen.
5. Select the cleanup option:

No Cleanup Keeps all messages.

Number of Messaged] Keeps the most recent messages

up to the number of messages indicated.
Age of Message$§] Keeps the messages that have been

in the inbox fewer days than the number of days indicated.

6. If the automatic cleanup is selected, type the maximum
number of days the message is retained in the inbox
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before it is deleted, or the maximum number of messages
retained before the oldest message is deleted.

t%:> Cleanup runs nightly, deleting only read messages and
those without alarms.

7. Selec{_Esit_]to accept the changes and return to the
Message Area screen.

To delete a personal inbox:

1. Selec{Re™ & from the menu wheel.
FE,

2. Prestu up or down to highlight the inbox you want to

delete, then sele( Delete |.

TIP All unread or alarmed messages in an inbox must be read,
deleted, or disabled before the inbox can be deleted.

3. Selec{_ves ]atthe confirmation screen to delete the
inbox and return to the Message Area screen.

To view the messages in an inbox:

1. Selec{Re™ & from the menu wheel.
FE,

2. Prestu up or down to highlight the inbox you want to

view, then pres'i.-'. A list of messages appears.
t%:> 2 indicates messages with alarms.
3. Select the message you want to view.

4. Selec{ Done |to return to the list of messages, or press
to return to the menu wheel.

Outbox

The Outbox serves two purposes. It provides a transmission
status log for messages sent within the past day and acts as a
holding area for unsent messages. All sent messages go into
the Outbox and stay there until a scheduled cleanup of the
Outbox takes place. The messages are categorized into six

types. Seled_Help ] to display the Outbox icon descriptions:

#  Sending in progress
v Sent successfully
& Message in queue
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®
X

Transmitter not on
Delayed send message
Sending failed (with an alert)

Due to the message transmission process, the transmission
status can alternate betwe Message in queuand

# Sending in progress before attainingy Sent successfully
status (see “The Home Screen” special status icons).

When the status of one of the messages in the Outbox changes,

the screen refreshes and the first item is highlighted.

To cancel outgoing messages in the Outbox:

3.

%
4.
5.

Selec{ R & from the menu wheel.
Select] Outbox.

F
Preseu up or down to highlight the unsent message you

want to cancel, then selg_ Delete |.

Only unsent messages can be canceled.

Selec{__ves ] at the confirmation screen.
Selec{_Exit__]to return to the Message Area screen, or

pressHOME) to return to the menu wheel.

To resend messages from the Outbox:

w

Selec *ed & from the menu wheel.
Select Outbox.

F
Presea up or down to highlight the message you want

to resend, then sele Resend J.

Only messages that have already been ! hof
messages that failed to transn{ ) can be resent.

Selec{_Exit__]to return to the Message Area screen, or
pressHOME to return to the menu wheel.

To resend a failed message from the Outbox:

1.

2.

Open the Outbox.
F

Preseu up or down to highlight the failed message you

want to resend, then selq Resend | andOK.
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TIP

Selec{_Exit__]to return to the Message Area screen, or
pressHOME) to return to the menu wheel.

If for any reason the message fails to transmit, the system
will present an automatically generated screen offering
you to resend the message. SeMES if you desire to do
Sso.

To view message information:

1.

Selec| *ed & from the menu wheel.
Selecﬂ‘i’l Outbox.

Pt
Presea up or down to highlight the message of interest,
then seled_Details |. The message, replies to the message,
and the addresses the message and replies were sent to
displays.
Selec{_Done_].

Selec{_Exit__]to return to the Message Area screen, or
pressHOME to return to the menu wheel.

To forward messages from the Outbox:

1.

Selec{ R & from the menu wheel.
Select] Outbox.

Pt
Preseu up or down to highlight the message you want
to forward, then presi.-'.

Selec{ Forward J.

Type a note to accompany the message being forwarded,
then select:

to forward to an address.
to forward to an inbox.

Select the address to which the message will be sent, then

selec{ Send |.
Selec{_Done .

Selec{_Exit__]to return to the Message Area screen, or
pressHOME) to return to the menu wheel.
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Trashcan

Messages can be restored from the Trashcan until the Trashcan
is emptied. The Trashcan is emptied upon your request, when
memory is running low, and each night. See “Memory
Management System” on page 71 for more information.

To restore a message from the Trashcan:

1. Selec{Re™ & from the menu wheel.

2. Selec! Trashcan.
F
3. Prestu up or down to highlight the message you want
to restore, then sele[ Restore J.

P
4. Presta up or down to highlight the inbox to which you
want to move the message, then se__0K__|.

5. Selec{_Esit_]to return to the Message Area screen, or
pressHOME to return to the menu wheel.

To empty the Trashcan:

Selec{ R & from the menu wheel.
SelecT Trashcan.
Selec{_Empty .

Selec{__ves ] at the confirmation screen to delete the
messages from the Trashcan.

5. Selec{_Esit_]to return to the Message Area screen, or
pressHOME to return to the menu wheel.

A wnh e

@% Customize

The Customize application provides a variety of features that
allow you to configure your PageWriter 2000X smart pager to
suit your needs.

Viewing System Status

Information available through the Customize application
includes system information, memory usage, and owner
information.
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To view system information:

1. Selec|{tustonize @% from the menu wheel.

2. SelectAbout PageWriter to view version, model, and
operating system information. A list of applications is also
provided.

3. Selec{_Done ]to return to the Customize screen, or press
to return to the menu wheel.

To view memory usage:

1. Selec|{tustonize % from the menu wheel.

2. SelectMemory Usageto view summary of the amount of
memory in use by various elements.

3. Selec{_DPone ]to return to the Customize screen, or
[Advanced 4 \jiew more detail about current and total

memory usage, or pre{oME) to return to the menu
wheel.

To view owner information:

1. Selec|tustonize % from the menu wheel.
2. SelecOwner Information to view your information.

TIP The information on this screen can be edited. Simply
delete any existing information and type the new
information.

3. Selec{ ok ]to accept any changes to the owner
information and return to the Customize screen, or press

to return to the menu wheel and discard any
changes.

Enabling and Disabling Alerts and Alarms

The Unread Message Alert feature indicates that you have
messages that were not read at the time they arrived and
continue to be unread. Using the same alerts you selected for
the inbox receiving the message, the Customize application
allows you to turn on or off the Unread Message Alert feature,
as well as the LED alarms.
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To enable/disable the unread message alert:

1. Selec|{tustonize @% from the menu wheel.
FE,

2. Prestu’ up or down to highlightJnread Msg Alert,

)
then pres®= to toggle betweefNow ON] and[Now
OFF].

3. Selec{_Done ]to return to the Customize screen.

To enable/disable LED alarms:

Customi @%
1. Selec|'s*o"'== from the menu wheel.
FE,

2. Prestu up or down to highlight ED Alarms,

o5
then pres®=- to toggle betweefNow ON] and[Now
OFF].

3. Selec to return to the Customize screen.

Setting Up Internet Fax Service

Before you can send fax messages you must first identify the
email address of the Internet fax service you intend to use.
Through the Customize application, record the email address

of your Internet fax service. If you make a change, your pager
restarts so the change takes effect. When you are ready to send
a fax, simply select the fax address from the Address Book for
the person you want to contact.

To set up an Internet fax service:

Selec| Bustonize 'E% from the menu wheel.
Selectnternet Fax Service
Type the email address for the fax service.

Do not enter the fax number or “@” sign.

Selec{ 0K ]to return to the Customize screen.

Customizing the User Interface

The Customize application enables you to adjust your
PageWriter 2000X smart pager to reflect your preferences.
Adjust the contrast level and message text size, select the date
and time formats, and even turn off or on the key clicks.
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To use the contrast calibration guide:

1. Selec|{tustonize @% from the menu wheel.

2. Presgat), then hold dowrfg. Watch the Calibration
Guide to see how the shades of black, gray, and white are
affected by your contrast selection.

3. Continue holdingg) down. The contrast adjustment will
automatically reverse when it reaches extreme light and
extreme dark contrasts. Reledgwhen the desired
contrast level is reached.

To select message text size:

1. Selec|{tustonize % from the menu wheel.
FE,

2. Prestu’ up or down to highlighiMessage Text

&)
then pres®=- to toggle between:

[Now NORMAL] O Displays all message text in the
standard font size.

[Now LARGE] O Displays all message text in a larger
font size.

3. Selec{ Done ]to accept the changes and return to the
Customize screen.

To select the date format:

1. Selec|{tustonize @% from the menu wheel.
FE,

2. Prestu’ up or down to highlighDate Format,
then pres.‘,@' to cycle between:
[Now DD/MM/YY] O Displays day/month/year format.
[Now YY/MM/DD] 0O Displays year/month/day format.
[Now MM/DD/YY] O Displays month/day/year format.

3. Selec{ Done ]to accept the change and return to the
Customize screen.

To select the time format:

1. Selec|{tustonize % from the menu wheel.
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P

2. Prestu up or down to highlighTime Format,

o5
then pres®=- to toggle betweefNow AM/PM] and
[Now 24 hr].

3. Selec to accept the change and return to the

Customize screen.

To turn on/off the key clicks:

1. Selec|{tustonize % from the menu wheel.
FE,

2. F‘ESSiU up or down to highlighKey Clicks, then press
o toggle betweefNow ON] and[Now OFF].

3. Selec{ Done ]to accept the change and return to the
Customize screen.

Customizing Message Features

Your PageWriter 2000X smart pager’'s messaging features
enable you to:

* Create a signature for your messages then automatically
append the signature to each message you send.

» Create and store frequently used text for inclusion in
future messages.

To create a signature:

Customi @%
Selec| “"stom ' = from the menu wheel.

1.

2. SelectSend Options

3. Select the Signature text box, then type your message
signature.

4. Selec{__0K_]to accept the change and return to the

Customize screen.

To automatically append your signature to each
message you originate:

1. Selec|{tustonize 'E% from the menu wheel.
2. SelectSend Options

t%:> To save air time your signature is not already appended to

replied messages.
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3.

SelectAdd Signature when sent(check appears in box).

Messages can be saved to an inbox on an individual basis. All
your outgoing messages are saved to the Outbox.

To create Quick Text:

Selec{ Fustonize % from the menu wheel.

1.

2. SelectEdit Quick Text.

3. SelectAdd New Quick Text.

4. Type your Quick Text message of up to 100 characters.

5. Selec{ 0k ]to accept the change and return to the
Quick Text screen.

6. Selec{ Dene ]to return to the Customize screen.

To edit Quick Text:
Selec| Pustonize % from the menu wheel.
SelecEdit Quick Text.

F

3. Prestu up or down to highlight the text requiring
changes, then seld_Edit _|.

4. Pres{BKSP) to delete existing text, then type your new
message.

5. Selec{ 0k ]to accept the change and return to the
Quick Text screen.

6. Selec{ Dene ]to return to the Customize screen.

Quiet Time

The Quiet Time feature lets you specify a daily time period
during which message alerts will not be played without
modifying the individual alert settings.

To set quiet time:

1.

»

Custoni @%
On the menu wheel, seld """ '*® .

Select Quiet Time Settings. The Quiet Time Settings
screen appears.

A
The On/Off switch is highlighted. Pre™&" left or right
to switch the setting between On and Off.

Presq{TaB) to move to the hour in the Start Time field.
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7.
8.

P

Prescue up or down to set the hour.
Pres{TAB) to move to the minute in the Start Time field.

F
Prescue up or down to set the minute.

Pres{TAB) to move to the AM/PM field in the Start Time

P

field. Presse” up or down to select AM or PM.
Repeat Steps 4 through 6 for the End Time.

Selec{_save_]to save the settings.

Message alerts will not be played during the time you set as
Quiet Time.

Maintaining Inboxes and Applications

Maintenance features such as Cleanup and Delete Applications
enable you to remove unwanted messages or applications from
your pager. To schedule the cleanup feature, see “To assign a
cleanup schedule to an inbox” on page 39.

To clean up all inboxes:

1.

Selec| Bustonize 'E% from the menu wheel.
SelecCleanup.
Select the containers to be cleaned:

All O Deletes all read messages stored in inboxes that
have no alarms set.
Inboxes Deletes all read messages stored in inboxes.

Messages deleted in the cleanup process are not stored in
the Trashcan. They are permanently deleted and cannot be
recovered.

Selec{_Done ] to delete the messages and return to the
Customize screen.

To delete applications:

1.

Customi @%
Selec| “"stom ' = from the menu wheel.

SelecDelete Applications
F

Pressie up or down to highlight the application

requiring deletion, then sele_Delete .
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4,

Selec{_ves ] at the confirmation screen to delete the
application and return to the Customize screen.

Setting the Alarm Clock

Set an audible or vibrating alert at up to three preset times.
These alarm clock alerts have no messages attached to them..

To set an alarm:

1.

10.

11.

Al Clk
From the menu wheel, sele. The Alarm

Clock screen has three tabs that enable you to set three
different alarms.

F
Pres<“a left or right, or(TAB) to select Alarm 1, Alarm 2,
or Alarm 3.

F FR
Press= down to move to the On/Off switch. Pre'ee"
left or right to select On or Off.

& Abellicon (':'-) on an alarm’s tab indicates that the
alarm is on. A bell icon also displays on the status line
of the menu wheel screen when an alarm is set.

FR
Pres{TAB) to move to the Frequency field. Pre"s" left
or right to select how often you want the alarm to go off.
Your options are Once, Weekends, Weekdays, or Every
day.
If you didn’t select a frequency of Once, skip to Step 6.

If you selected Once, a Date field becomes active just
below the Frequency field. Pre(TaB) to move to the Date

F

field. Presswe- left or right to change the date (one day at
atime).
Presq{TaB) to move to the hour in the Time field.

F
Prescie up or down to change the hour.
Pres{TAB) to move to the minute in the Time field.

4T
Preseu up or down to change the minute.
Pres{TaB) to move to AM/PM in the Time field.

P

Prestie’ up or down to select AM or PM.
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F
12. Pres{TAB) to move to the Alert field. Pres'=" left or
right to select the type of alarm you want (audible, vibrate,
etc.).

13. To set other alarm times, repeat for the second and third
alarm tabs.

14. Selec[_Dene |to save the settings and return to the menu
wheel.

@ FLEX PC Partner

Introducing FLEX PC Partner

The FLEX™ PC Partner application enables you to transfer
information between your personal computer (PC) and your
PageWriter 2000X smart pager. The application enables you
to manage the following common information management
tasks:

* Adding information to your Address Book on your PC,
then updating the Address Book on your pager

»  Copying information from your pager to your PC (as a
backup or for editing purposes)

*  Copying information from your PC to your pager

» Printing all messages stored on your pager

» Copying all messages stored on your pager to your PC
» Installing a new application on your pager

» Updating the operating system on your pager

The FLEX PC Partner application handles the various
information transfers and related operations with small

component programs. The Partner appletpaotlets are
accessed from a control panel known as$hell

PC Hardware Requirements

In order to connect properly with your pager, your PC must
meet the following minimum requirements:

* IBM-compatible 486SX 66 MHz processor or greater

e 16 MBRAM

e 7 MB of available storage on the computer's hard drive
*  VGA monitor with 640x480 resolution
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» PageWriter 2000X docking station to supply infrared
connection (provided with the unit)

PC Software Requirements
Windows 95, 98 or NT must already be installed on your PC.

FLEX PC Partner Online Help

Online Help is accessible by pressi@ on your PC
keyboard at any time while in the FLEX PC Partner
application. Clicking the Help button on a FLEX PC Partner
dialog box brings up context-specific help.

Installing FLEX PC Partner on Your PC
The FLEX PC Partner application includes a setup program
that automatically copies the program files to the appropriate
folders on your PC. Setup creates the folders for you if they
don't already exist.

To install FLEX PC Partner on your PC:

1. InsertFLEX PC Partner Disknto the disk drive on your
PC.

2. From the Windows taskbar, clickart, thenRun.

3. Select or typ&\SETUP.EXE. (If the disk is in a drive
other than A:, substitute the appropriate drive letter.) Press

[Enter] .

4. Follow the prompts. Typically, you will want to accept the
option on each screen that Setup has already selected (the
default).

5. When Setup is complete, cli€kK at each information
window.

6. Click[_¥es |to read the Release Notes. They contain
important information that might not have made it into the
documentation. Close the Release Notes before
continuing.

7. Selecw@ FLEX PC Partner to start the PC Partner
Shell.

Linking Your PageWriter 2000X to Your PC

The connection that enables your pager and your PC to
exchange information is a combination of an infrared (IR) link
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and direct cabling. The Deluxe chargerdarcking stationhas

a built-in IR port. When you snap your pager into the docking
station the IR port on your pager aligns with the IR port on the
docking station. The docking station is connected to one of
your PC's serial ports via the Motorola-supplied RS232 null
modem cable. The LED on your pager flashes RED and
GREEN indicating IR communication between the PC and
your pager.

To establish a connection between your pager and
FLEX PC Partner on your PC:
1. Snap your pager into the docking station. For information

on connecting the docking station to your PC, see “The
Infrared Port” on page 16.

2. Onyour pager, sele| "2"tmer @ from the menu
wheel.

Selec( Commeet |

4. Ifthis is the first time the FLEX PC Partner application is
being installed on your PC continue to the next section,
“Configuring FLEX PC Partner”. Otherwise, see “Using
the PC Partner Shell” on page 54.

Configuring FLEX PC Partner

The FLEX PC Partner Configuration utility is run immediately
after installing FLEX PC Partner. It tells the FLEX PC Partner
application how your pager will be connecting to your PC. If
you change hardware (e.qg., replace the charger with a new type
of charger) reconfigure the FLEX PC Partner application using
the following procedure.

To configure FLEX PC Partner:

1. From your desktop, double—cli(@ FLEXPC
Partner.

-or-
From the Windows 95 taskbar, cliéart, then point to

FLEX PC Partner and click FLEX PC Partner.
Y

T -l

2. From the PC Partner Shell, double-c @ Partner
Configuration.
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3. Fromthe FLEX PC Partner Configuration dialog box,
select the appropriate serial port.

t¥:> If the port selection is not correct, an error message
appears (“No IR devices found”).
4. Inthe Adapter list box, select the appropriate adapter.

5. Click OK. If this is not the first time FLEX PC Partner
has been configured to your PC, cli¥lesto save your
choices and close the FLEX PC Partner Configuration
partlet.

Using the PC Partner Shell

The FLEX PC Partner application consists of individual
component applications accessible from the FLEX PC Partner
Shell, known agpartlets Since each partlet operates
independently, they can be used in any order. Except as noted
below, you must establish a connection between your pager
and your PC in order to open a partlet.

The following partlets are currently available:

* Address Book (does not require connection to pager)

* Memory Usage

» Message Manager (does not require connection to pager)
»  Backup Utility

* Restore Utility

* Application Manager

» Partner Configuration

A,r FLEX PC Partner - Partlets =]
Fil=  Help
e e i et Pt e e

& = & i @
Address Book Memary Usage  Message Backup Lttty Restore Uity Spplication Pattrer
llanager IManager Configuration

To open the FLEX PC Partner Shell:

From your desktop, double—cli(@ FLEX PC Partner.
_Or_
From the Windows 95 taskbar, cli@tart, then point to

FLEX PC Partner and click@ FLEX PC Partner.

54 PageWritef™ 2000X User's Manual



To open a FLEX PC Partner partlet from the
Shell:

1. Double-click the partlet's icon.

TIP Right-clicking an icon also displays a pop-up menu you
can use to open a partlet.

2. Ifthe FLEX PC Partner Connect dialog box appears, click
Connect

To determine a partlet's version:
1. Fromthe FLEX PC Partner Shell, click the partlet's icon.

2. From the File menu, clicRroperties. The partlet’s
version number displays.

TIP Right-clicking an icon also displays the File menu.

Managing Your Address Book

The FLEX PC Partner Address Book enables you to transfer
the Address Book information from your PageWriter 2000X
smart pager to your PC. You can then conveniently view and
edit name and address information on your PC and send the
revised information back to your pager.

Address Book management includes:

* Transferring Address Book information between your
pager and your PC

* Managing your Address Book files on your PC
* Managing Address Book entries for individuals
* Managing Address Book entries for groups

*  Printing Address Book information

Transferring Address Book Information

The FLEX PC Partner application enables you to transfer your
Address Book information from your pager to your PC where

it can be easily edited or stored as a backup file. Edited
Address Book files should be transferred back to your pager to
synchronize your PC and pager Address Books.

t%:> Files saved to your PC use an .ADR extension.
Information in .ADR files can be edited through the FLEX
PC Partner Address Book partlet.
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t%:> The amount of RAM in your pager is always checked
when you connect it to the PC. If the RAM is low, a
message on the pager warning of the low RAM condition
displays, asking if you want to reset your pager to free up
used space in RAM. If you select Yes, the pager restarts.
If you select No, your pager automatically exits the PC
Partner application.

To transfer your Address Book information from
your pager to your PC:
1. Snap your pager into the docking station.

2. Onyour pager, sele| "2"tmer @ from the menu
wheel, then sele( connect ] and wait for the Connection
Status screen:

atotus
i,
Ll

aiting to conmect...

L - v

Paging functions are temporarily suspended while your pager
is connected to your PC. Incoming messages will be retained
by the paging service provider until your pager is disconnected
from your PC.

3. Onyour PC, open the FLEX PC Partner Shell, then

Lol

double-clic} Address Book

4. Click = , or from the File menu, clickset From
Pager.

5. Click Connect Status messages on your PC screen notify
you of the progress of the transfer. When the transfer is
complete, the Address Book is updated on your PC.

You can now add, edit, or delete Address Book
information on your PC. After editing Address Book
information on your PC, you can save it to a file on your
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PC or send the information back to your pager to update
the Address Book on your pager.

TIP When you selecGet From Pager, the currently open
Address Book on your PC is replaced by the Address
Book being transferred from your pager. Before
transferring the file, save the Address Book on your PC to
another file name.

TIP To merge Address Books, ensure the Address Books are
saved as separate .ADR file names, then merge them using
the Import/Merge menu command. See “To merge two
Address Book files on your PC” on page 59 for
instructions on merging two Address Book files.

6. Click E , or from the File menu, clicilSave

7. Select the file location, type the name for the new Address
Book file, then clickSave

To transfer your Address Book information from
your PC to your pager:
1. Snap your pager into the docking station.

2. Onyour pager, selef Portme" @ from the menu
wheel, then sele{ Connect | and wait for the Connection
Status screen.

3. Onyour PC, open the FLEX PC Partner Shell, then
el

double-click Address Book

oo

4. Click , or from the File menu, clickOpen.

5. Select or type the name of the .ADR file you want to
transfer, then cliclOpen.

=]
6. Click , or from the File menu, clicksend To Pager

Click Connect Status messages on your PC screen notify
you of the progress of the transfer.

TIP If you have made changes to the Address Book on your
pager that are not included in the Address Book on your
PC and you do not want to lose the changes, transfer the
Address Book on your pager to your PC. Save the file to a
different .ADR name, then merge the file with the Address
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Book on your PC. Send the final merged Address Book to
your pager.

On your pager, sele[Disconnect | .

t%:> Your paging functions are suspended while a connection
exists between your pager and PC. When you have

finished transferring data, sel{Disconnect | to re-enable

the send and receive functions.

©

Managing Address Book Files
Managing your Address Book files comprises creating, saving,
opening, merging, importing and deleting the files.

té{> Your pager does not need to be connected to your PC to
perform the following procedures, unless noted otherwise.

TIP Delete .ADR files that you no longer need.

To create an Address Book file on your PC:

1. Onyour PC, open the FLEX PC Partner Shell, then
il

double-click Address Book

2. Click , or from the File menu, clicNew. If an
existing Address Book file is open, FLEX PC Partner
prompts you to save your changes before closing it.

A blank Address Book appears, ready for you to enter
new addresses and create new groups.

3. Upon completing entries in your new Address Book, click

E ,or select the File menu, then cliSave

4. Select the file location, type the name for the new Address
Book file, then clickSave

To save an open Address Book file on your PC:

With the Address Book file open, clig H , or from the File
menu, clickSave

If this Address Book file has not been saved already, FLEX
PC Partner prompts you for a file name. Type the file name,
then clickOK.
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To save an open Address Book file under a new

name:

1. From the File menu, clicBave As

2. Select the file location, type the new name for the Address
Book file, then clickSave

té{> You do not need to type the file extension. The FLEX PC
Partner application automatically appends the .ADR
default extension.

To open an Address Book file on your PC:
1. Onyour PC, open the FLEX PC Partner Shell, then

Ly

double-click Address Book

2. Click , or from the File menu, clickOpen.

3. Select the Address Book (.ADR) file you want to open,
then clickOpen. Once the desired Address Book file is
open, you can add, edit, or delete address entries or group
entries.

To merge two Address Book files on your PC:

1. Onyour PC, open the FLEX PC Partner Shell, then
ol

double-click Address Book

2. Click , or from the File menu, clickOpen.

3. Select the Address Book (.ADR) file you want to open,
then clickOpen.

TIP The second Address Book file you select will merge into
the first Address Book file. You might want to save a
copy of the first file prior to performing the merge.

t¥:> The Import/Merge command does not merge Address
Book groups.

4. From the File menu, clicknport/Merge .

5. Select or type the name of the second Address Book file
to be merged, then clickpen.

6. Click E , or from the File menu, cliclSave
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To import Address Books from other PC-based
applications:
1. Onyour PC, open the FLEX PC Partner Shell, then

¥

double-click Address Book
From the File menu, clicknport/Merge .

N

t%:> This menu command merges files into the currently open
Address Book file.

3. Select or type the name of the file to be merged into the
Address Book, then clicopen.

t¥:> The Import/Merge command does not merge Address
Book groups.

TIP Import/Merge supports .CSV, .VCF, and .ADR files for
merging. Import files that are of the same format as those
created by the Export command on the File menu. These
files can be edited in database and spreadsheet programs
that use comma-delimited text. The Import/Merge
command does not merge Address Book groups.

4. Click g , or from the File menu, cliciSave

To delete an Address Book file from your PC:
From Windows Explorer or File Manager, highlight the .ADR
file you want to delete, then pre.

Managing Addresses of Individuals

Use the Individual menu on the Address Book main screen to
add, edit, or delete individuals.

té{> Your pager does not need to be connected to your PC to
perform the following procedures.

t¥:> Remember! Performing the following procedures affects
only the Address Book on your PC. To update the
Address Book on your pager, see “Transferring Address
Book Information” on page 55.
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To add an individual to the Address Book on your
PC:

1.

TIP

E OO

9.

G

On your PC, open the FLEX PC Partner Shell, then

double-click Address Book
Open the appropriate Address Book file. For more

information, see “Managing Address Book Files” on
page 55 for instructions on opening a file.

Click g , or from the Individual menu, clicklew.

In the Name field, type the name for the entry as it should
appear in the Address Book (e.g., Cody, Catherine).

The Address Book sorts address entries alphabetically
based on the first letter in the address name. Type the last
name first if you want to find addresses for individuals by
their last name.

In the Pager Type field, select the pager type.

Type the individual's PIN for their pager.

The label and carrier-specific PIN entry instructions for
this field are determined by the selected pager type.

Type other address information, such as fax number,
home phone number, work phone number, email address,
or your personal notes.

Click OK.

The new entry appears in the address list.

,Q. indicates the address is for an individual. Information
for the highlighted entry appears below the address list.

To edit an individual's information in the Address
Book on your PC:

1.

On your PC, open the FLEX PC Partner Shell, then
il

double-click Address Book
Open the appropriate Address Book file. For more

information, see “Managing Address Book Files” on
page 55 for instructions on opening a file.

Highlight the entry you want to edit, then cli @ , or
from the Individual menu, clicledit.
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4, Edit the individual’s information.

TIP Use the arrow keys to move the cursuthin a field in the
upper pane. UsBa ] to move the cursobetweerfields.

t¥:> The Notes field holds up to 100 characters. Once you
have reached the 100-character limit, existing characters
must be deleted before more characters can be added.

5. ClickOK.

To delete an individual from the Address Book on
your PC:
1. Onyour PC, open the FLEX PC Partner Shell, then

double-click Address Book
2. Open the appropriate Address Book file. For more

information, see “Managing Address Book Files” on
page 55 for instructions on opening a file.

3. Highlight the entry you want to delete, then cl W , or
from the Individual menu, clicloelete

4. Click Yesat the confirmation screen.

Managing Addresses of Groups

A group address is a collection of individual addresses
associated to one name in your Address Book. When you send
a message to a group, the message goes to all members of the
group without having to select each member individually. An
individual in your Address Book can be a member of several
groups.

Use the Group menu on the Address Book main screen to add,
edit, or delete groups.

t%:> Your pager does not need to be connected to your PC to
perform the following procedures.

t%:> Remember! Performing the following procedures affects
only the Address Book on your PC. To update the
Address Book on your pager, see “Transferring Address
Book Information” on page 55.
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To add a group to the Address Book on your PC:
1. Onyour PC, open the FLEX PC Partner Shell, then

double-click Address Book
2. Open the appropriate Address Book file. For more

information, see “Managing Address Book Files” on
page 55 for instructions on opening a file.

3. Click @ , or from the Group menu, clickiew.

4. Inthe Group Name field, type the name for the group as it
should appear in the Address Book (e.g., Sales Team).

TIP You can force address names to appear in a position in the
Address Book that you find convenient. For example,
prefacing group names with a space forces all the groups
to appear at the top of the list. Using an underscore
instead forces the names to the bottom of the list.

5. Inthe Available Addresses list on the left, select the
addresses you want to add to the group, then didé.
The selected addresses appear in the Group Members list
on the right.

TIP To select a series of addresses, highlight the first address,

hold down[snit], then left click the mouse button on the
last address. To select multiple addresses that are not in a

series, highlight the first address, hold dofem] while
you left click the mouse button on each additional address.

6. When you have finished adding all the addresses for this
group, clickOK. The new group appears in the address
list on the Address Book main screen.

t¥:> B indicates the address is for a group. The addresses
assigned to this group are listed below the address list.

To add addresses to a group in the Address Book
on your PC:
1. Onyour PC, open the FLEX PC Partner Shell, then

¥

double-click Address Book
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2. Open the appropriate Address Book file. For more
information, see “Managing Address Book Files” on
page 55 for instructions on opening a file.

3. Highlight the group you want to edit, then cli ﬁ , or
from the Group menu, clicidit.

4. Inthe Available Addresses list, select the address(es) to
be added.

TIP To select a series of addresses, highlight the first address,

hold down[shit], then left click the mouse button on the
last address. To select multiple addresses that are not in a

series, highlight the first address, hold dofem] while
you left click the mouse button on each additional address.

5. ClickAdd.
6. ClickOK.

To remove addresses from a group in the Address
Book on your PC:

1. Onyour PC, open the FLEX PC Partner Shell, then
il

double-click Address Book

2. Open the appropriate Address Book file. For more
information, see “Managing Address Book Files” on page
55 for instructions on opening a file.

3. Highlight the name of the group you want to remove

addresses from, then cli @ , or from the Individual
menu, clickEdit.

4. Inthe Group Members list, select the address(es) to be
removed.

5. Click Remove
6. ClickOK.

To delete a group from the Address Book on your
PC:

1. Onyour PC, open the FLEX PC Partner Shell, then
ol

double-click Address Book

64 PageWritef™ 2000X User's Manual



5.

Open the appropriate Address Book file. For more
information, see “Managing Address Book Files” on
page 55 for instructions on opening a file.

Highlight the name of the group you want to delete.

Click ﬁ , or from the Group menu, clicRelete or
presse).

Click Yesat the confirmation screen to delete the group.

té{> This procedure deletes only the group name. It does not

delete the individual members of the group. To delete the
individual members, see “Managing Addresses of
Individuals” on page 60.

Printing Address Book Information

The FLEX PC Partner application enables you to check or
reset the printer setting, then preview the printed Address
Book information prior to printing the selection.

To set up a FLEX PC Partner printer:

1. Onyour PC, open the FLEX PC Partner Shell, then
il
double-click Address Book

2. Open an Address Book file. For more information, see
“Managing Address Book Files” on page 55 for
instructions on opening a file.

3. From the File menu, clicRrint Setup.

4. Inthe Print Setup dialog box, select the appropriate
printer settings. For more information, see your printer’s
user’'s manual.

5. Click OK.

To preview your printed Address Book

information:

1.

On your PC, open the FLEX PC Partner Shell, then

Ly

double-click Address Book

Open the Address Book file you want to view. For more
information, see “Managing Address Book Files” on
page 55 for instructions on opening a file.

From the File menu, clicRrint Preview. For more
information, see your printer’s user's manual.
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4,

Click Closeto close the preview window.

To print your Address Book information:

1.

4.

5.

On your PC, open the FLEX PC Partner Shell, then

il
double-click Address Book
Open the Address Book file you want to print. For more

information, see “Managing Address Book Files” on
page 55 for instructions on opening a file.

Click % , or from the File menu, cliclrint.

In the Print dialog box, select the appropriate settings. For
more information, see your printer’s user’'s manual.

Click OK.

Managing Your Messages

FLEX PC Partner's Message Manager partlet transfers
messages from your pager to your PC so you can view, print,
copy, or store the messages on your PC.

To transfer messages from your pager to your PC:

1.

2.

Snap your pager into the docking station.

On your pager, sele| 72"t "" @ from the menu
wheel, then sele{ Connect ] and wait for the Connection
Status screen.

On your PC, open the FLEX PC Partner Shell, then
R il

double-click =] Message Manager

Click|®¥| or from the File menu, clickset Messages
From Pager.

Click Connect

The text on the status bar reflects the progress of the
transfer as the messages are retrieved from your pager.
When the transfer is complete, the status bar displays
Ready, and the retrieved messages appear on the screen.

Click g , or from the File menu, cliclSave As

Select the file location, type the name for the message file,
then clickSave
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To read messages previously stored on your PC:

1.

2.
3.

On your PC, open the FLEX PC Partner Shell, then
R il

double-click =] Message Manager

T

Click|l&” , or from the File menu, clickopen.
Select the message (.PWM) file, then cl@gen.

To print messages:

1.

G

Transfer from your pager to your PC the messages you
want to print. For more information, see “To transfer
messages from your pager to your PC” on page 66.

Click @ , or from the File menu, cliclrint. The
messages print using your default printer settings.

Print Setup enables you to change printer options. For
more information, see your printer’s user’'s manual.

To copy text from a message to another PC
application:

1.

e

© N o o

G

Transfer the messages from your pager to your PC. For
more information, see “To transfer messages from your
pager to your PC” on page 66.

In the Folder list, select the folder in which the desired
message is stored.

In the Messages list, select the desired message.

In the Message Text pane, highlight the text you want to
copy.

Click , or from the Edit menu, cliciCopy.
Start the application into which you want to paste the text.
Position the cursor where you want to paste the text.

From the Edit menu, clicRasteto paste the message text
at the location of the cursor.

Text cannot be pasted into or deleted from an existing
message.
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To save messages to your PC:

1. Transfer the messages from your pager to your PC. For
more information, see “To transfer messages from your
pager to your PC” on page 66.

2. Inthe Folder list, select the folder in which the desired
message is stored.

3. Inthe Messages list, select the desired message.

4. Click E , or from the File menu, cliclBave As

5. Select the file location, type the file name for the
message(s) to be saved, then clidve

Installing and Removing Applications

FLEX PC Partner’s Application Manager enables you to add
new applications to your PageWriter 2000X smart pager, or to
remove applications that you no longer use. It also displays the
creation date of any applications installed on your pager.

TIP Before adding or removing applications from your
PageWriter 2000X smart pager, perform a backup of the
data.

To install a new application on your pager:
1. Snap your pager into the docking station.

2. Onyour pager, selef Portmer @ from the menu
wheel, then sele{ Connect ] and wait for the Connection
Status screen.

3. Onyour PC, open the FLEX PC Partner Shell, then

S e
double-click Application Manager.
4. Click Connect

5. If the new application is on a diskette, insert the diskette
into the appropriate diskette drive.

6. Click Install New Application.
7. Select the application file to be installed.

8. Click Open. A message appears when the installation is
complete, and the new application is included in the list
on the Application Manager.

9. Click Exit.
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To remove an application from your pager:
1. Snap your pager into the docking station.

2. Onyour pager, selef Portmer @ from the menu
wheel, then sele{ Connect ] and wait for the Connection
Status screen.

3. Onyour PC, open the FLEX PC Partner Shell, then

S e
double-click Application Manager.

4. Select the application to be removed, then cR&move
Application.

t%:> Core applications cannot be removed.
5. Click Exit.

Backing-up and Restoring Information

The FLEX PC Partner Backup partlet enables you to copy the
data from your pager to your PC. The data that is backed up
includes your messages, your Address Book information, and
your pager's applications.

Use the Restore partlet to copy your pager data stored on your
PC back to your pager.

Caution

The Restore operation overwrites any existing data on your
pager.

To copy data from your pager to your PC for
backup:
1. Snap your pager into the charger.

2. Onyour pager, sele| "2"tmer @ from the menu
wheel, then sele( connect ] and wait for the Connection
Status screen.

3. Onyour PC, open the FLEX PC Partner Shell, then
Al

double-click ﬁ Backup Utility .
4. Atthe initial screen, cliciNext.

5. Atthe Select Backup File screen, select a destination for
the file containing the saved information, then clidkxt.
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t%:> A default FLEX PC Partner folder is provided, however,
you can change its filename and location.

6. Click Connectto start the backup.
t¥:> File transfer may take several minutes, depending upon
how much data you have on your pager.

7. Atthe success screen, cli€iK to close FLEX PC
Partner and drop the connection to your pager.

To restore data to your pager from your PC:
1. Snap your pager into the docking station.

2. Onyour pager, selef Portmer @ from the menu
wheel, then sele{ Connect ] and wait for the Connection
Status screen.

3. Onyour PC, open the FLEX PC Partner Shell, then

il

double-click Restore Utility.
4. Atthe initial screen, clickext.

5. Atthe Select Backup File screen, select the file containing
the saved information you want to restore to your pager,
then clickNext.

6. Click Connectto start the restore.

Caution

All data on your pager (saved messages, Address Book entries,
and applications) is deleted and replaced by the version of the
data that was restored from your PC. This means that if you
made changes to your Address Book on your pager after the
last backup to your PC, you will lose those changes during this
restore.

7. When the confirmation message appears, €k

Checking Memory Usage on Your
PageWriter 2000X

The FLEX PC Partner Memory Usage partlet enables you to
monitor the allocation of persistent storage on your pager.
When the Memory Usage partlet indicates that the free
memory on your pager is getting low, you can increase the free
memory level by deleting old messages or applications.
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t%:> The memory usage levels refergersistent flash storage
(analogous to the hard drive on your PC) rather than
volatile memoryRAM). The Memory Usage partlet does
not monitor RAM.

To check memory usage on your pager:
1. Snap your pager into the charger.

2. Onyour pager, sele| "2"tmer @ from the menu
wheel, then sele( connect ] and wait for the Connection
Status screen.

3. Onyour PC, open the FLEX PC Partner Shell, double-

i -l
click Memory Usage

TIP If you add or delete information from your pager while
Memory Usage is open, clidRefreshto update the
memory usage information.

4. Click Exit.

Uninstalling FLEX PC Partner
1. From the Windows taskbar, cIicSktart, then point to

L
R r

FLEX PC Partner and click “Ii] Uninstall Partner.

2. Click Yesat the confirmation screen to delete FLEX PC
Partner and all of its components.

Memory Management System

The PageWriter 2000X internal memory management system
automatically performs maintenance tasks. These tasks ensure
sufficient memory is available to receive incoming messages
and to support your processing requirements. To maximize
memory efficiency, messages are deleted in the following
order:

t%:> Messages deleted during the cleanup process are not
moved to the Trashcan; they are permanently deleted.

té{> Unread and alarmed messages are deleted from inboxes
that contain 250 messages or if the Number of Messages
cleanup option is selected and the limit for the number of
messages has been reached.
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Trashcan— Automatically configured to empty each night at
midnight (you may specify the cleanup of inboxes and the
Outbox, as well); midnight cleanup deletes messages placed in
the Trashcan 24 to 48 hours earlier. Messages placed in the
Trashcan within the last 24 hours are deleted at midnight the
next day. The Trashcan is the first container the system
empties when memory space is required (deleting as many
messages as necessary to make room for incoming messages).

Outbox — Deletes all sent/unsaved messages from the
transmission area of the Outbox starting with the oldest
message first. The transmission status is retained but the text
of each message is deleted.

Main Inbox —Deletes all read messages from the Main Inbox
starting with the oldest message first.

Personal Inboxes— Deletes all read messages from personal
inboxes starting with the oldest message first.

Information Services Inboxes— Deletes all read messages
from each information service inbox starting with the oldest
message first.

Reminders and Alarmed Messages— Deletes any alarmed
inbox message or Reminder where the alarm has already gone
off; messages are deleted in the following order:

1. Maininbox

2. Personal inboxes

3. Information Services inboxes
4, Reminders

Alarmed messages that are set for periodic alarm (e.g. the
alarm goes off every week) will not be deleted.

Unread Messages— If memory space istill needed, deletes
unread messages from the inboxes in the order described
above.

t%:> Messages in Address Book entries and locked messages
are not subject to automatic deletion.

When a warning message is displayed, the PageWriter 2000X
smart pager enables you to access the View Memory Usage
screen. Once you have determined the area where cleanup may
be most effective, you can select:

Cleanup All O Deletes all read messages in each inbox.
Cleanup Inboxesd Deletes all read messages in each inbox.
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Proper Care and Cleaning

The PageWriter 2000X smart pager is durable, reliable, and

can provide many years of dependable service, butitis a
precision electronic product. Water and moisture, excessive
heat, and extreme shock may damage the pager. Do not expose
your PageWriter 2000X smart pager to these conditions.

Use a soft, damp cloth to clean smudges and grime from your
PageWriter 2000X smart pagd€o not immerse in water.

Do not use alcohol or other cleaning solutions.

To protect the operating system, applications, and data on your
PageWriter 2000X smart pager, ensure that the PC from which
you download files is protected by up-to-date virus protection
software. Remember to archive your data, as needed.

General Safety Instructions

Follow these guidelines to ensure the safe use of your
PageWriter 2000X smart pager and accessories.

Pager Transmitter Safety

The FAA has regulations concerning the use of electronic
devices aboard aircraft. When boarding an aircraft, set the
radio transmitter mode to Off on your PageWriter 2000X
smart pager to avoid potential interference with aircraft radio
communication or navigation equipment.

In hospital or blasting zones, set the radio transmitter mode to
Receive Only. This prevents potential transmission
interference with sensitive medical equipment or explosives
devices.

Battery Safety

» Do not dispose of the rechargeable NiMH battery in fire.
Batteries can explode when exposed to fire.

» To preventinjury or burns, do not allow metal objects to
contact or short circuit the battery terminals.

* Recharge the Motorola 3.6 V NiMH battery
(0186386G01) only with the recommended Motorola
battery charger (0186388G02). Charging this battery by
any other method or with a product not approved by
Motorola may cause damage to the battery.
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» Do not charge batteries other than Motorola’s 3.6 V
NiMH battery (0186386G01) in the Motorola battery
charger (0186388G02). Charging other batteries can cause
those batteries to burst or explode, resulting in personal
injury or property damage.

Battery Charger Safety
» Do not expose the charger to rain or snow.

» Use of an attachment not recommended or sold by
Motorola may result in a risk of fire, electric shock, or
injury to persons.

» Make sure the cord is located where it will not be stepped
on, tripped over, pinched, or subjected to damage or
stress.

* If you need to use an extension cord, make sure:

— the pins on the plug of the extension cord are the
same number, size, and shape as those on the plug of
the charger;

— the extension cord is properly wired and in good
electrical condition; and

— the cord size is 18AWG for lengths up to 100 feet and
16AWG for lengths up to 150 feet.

» Do not operate the charger with a damaged cord,
transformer block, or prongs; replace them immediately.

* Do not operate the charger if it has been damaged in any
way; take it to a qualified service technician.

» Do not disassemble the charger; if service or repair is
required, call Motorola at 1-800-548-9954. Incorrect
reassembly can result in a risk of electrical shock or fire.

*  Maximum ambient temperature around the power supply
must not exceed 4C (104F).

» Keep battery contacts clean. Do not allow dirt or sticky
substances to accumulate on the contacts. If you need to
clean the contacts, unplug the charger to reduce the risk of
electrical shock. Use a slightly dampened cloth to clean
the contacts. Let the contacts dry before plugging the
charger into an AC outleDo not immerse in water.

Agency Approvals

The PageWriter 2000X smart pager has been approved for use
by the Federal Communications Commissions (FCC) and
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Underwriters’ Laboratories, Inc. (UL). The charger/docking
station has been FCC approved and the transformer has been
UL approved.

Patent Information

This product is manufactured under one or more Motorola
U.S. Patents. A partial listing of these patents is provided
inside the battery compartment. Other patents covering this
product are pending.

PageWriter 2000X Specifications

Physical Dimensions

Size 3.75x2.85x1.2in
95 x 72 x 29 mm

Weight (w/battery) 6.7 0z
190g
Volume 9.3in
153 cc

Graphics Display
1/8 VGA 16 lines x 30 characters
240 x 160 pixels
4-level gray scale
EL backlighting

Message Area 9 lines x 27 characters
Power
Main Battery Pack 3.6 V NiMH
Charge Time 1hr
Backup Cell rechargeable
Battery Life >7 days
Clock Retention Time

w/main battery removed 15 min
Max. Sound Pressure Level (at 12 inches) 72 dB
Memory
Total Memory 4.25 MB

4 MB Flash

3 MB (FLEX OS)
1 MB (Applications and Data)
256 KB RAM

Environment
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Operating Temperature 3 122F

0° to +50°C
Storage Temperature 1t 149F
-10° to +65°C

Electrostatic Discharge (no permanent damage) 15kv

Commonly Asked Questions

Your PageWriter 2000X smart pager is a dynamic messaging
device. It monitors and processes your communications even
when you are busy with other things. The following questions
reflect situations that may occur and are organized into four
categories:

» PageWriter 2000X

* Messaging

» Battery and Charger

* FLEXPC Partner

PageWriter 2000X

Why won'’t my pager power up?
Your PageWriter 2000X smart pager might not be accessing
the power it requires.

» Make sure you have a battery in the battery compartment.
If not, insert a fresh battery.

» Make sure the battery is inserted properly. Check that the
+ marking on the battery is positioned on the two-contact
side of the battery compartment. Press the battery into the
compartment to ensure the battery is seated properly. For
more information, see “To replace the battery” on
page 14.

* Recharge the battery or insert a fresh battery.

» Ifthe front LED lights when you replace the battery and
the screen is still blank, your screen’s contrast may be too
light. Adjust the contrast. See “My screen is too dark (or
too light). How do | change it?".

My screen is too dark (or too light). How do |
change it?

You can quickly change the contrast by presgais), then
holding downég until reaching the desired contrast. Your
PageWriter 2000X smart pager also has a built-in calibration
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guide to help you select the best contrast level. For more
information, see “To use the contrast calibration guide” on
page 46.

Periodically, the date and time are incorrect. What
causes this?

The clock will maintain its accuracy for about an hour after the
battery has been totally drained of power. To retain date and
time accuracy, replace the battery, as needed. During extended
periods of non-use (i.e., overnight), place your pager in the
plugged-in charger so the battery will be fully charged in the
morning. While using your pager, an extra battery can be kept
in the plugged-in charger until needed.

t¥:> The charger is intentionally designed so that you cannot
place both the extra battery and the pager in the charger at
the same time.

My pager is acting funny. What's wrong?

The amount of random access memory (RAM) available on
your pager constrains the number of processes that can run at
any given time. Symptoms of Low RAM status include:

* menu wheel won't spin

» time and date disappear from the screen

» allinbox message counts display zero

e Customize list box is empty

» text box is empty when attempting to forward a message
* nightly cleanup failed to run

These symptoms allow the pager to conserve RAM use. Reset
your pager to correct the Low RAM status (turn your pager

off, then back on again). To avoid a Low RAM status, turn off
your pager at night when it is not being used.

té{> An Out-of-RAM status will cause the pager to reset itself.

Deleting my old messages did not help the Low
Memory status. What should | do?

Messages that are deleted from inboxes are held in the
Trashcan until the Trashcan is emptied. A cleanup schedule is
assigned to empty the Trashcan. When you delete messages
from inboxes to alleviate overuse of memory, you are only
shifting memory use from one file storage area to another.
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After deleting messages, you must empty the Trashcan to free
the memory for use (see “To empty the Trashcan” on page 43).

Messaging

Why don't | receive messages?

Situations that will prevent you from receiving messages
include:

* Your pager’s radio mode may be set to Off. From the
Home screen, the status line will display “Storing
Messages”. Reset your transmission mode to
Send/Receive or Receive Only. For information on
resetting you transmission mode, see “To set the
transmission mode” on page 20.

* Your pager might be out of range of the nearest
transmitter. Check the icon in the lower right corner of the
Home screen. If you are out of range, your messages will
be transmitted when you are back within transmission
range.

Why does the Home screen status line read “Basic
Service” when the radio mode is set to
Send/Receive?

If you have just inserted a new battery or just disconnected the
pager from your PC, it can take a few minutes before you have
“Full Service” access. Your pager reregisters with the service
provider after any suspension in service. Also, if you are on
the perimeter of the transmission range, you might only have
message reception capabilities.

Why does the Home screen status line read
“Storing Messages”?

When your pager loses access to your service provider’'s
paging network, your messages are stored by the paging
network until your pager is ready to receive the messages.
Reasons why your pager might be unable to receive messages
include:

* You have manually turned off transmission to your pager.
This occurs by setting the transmission mode to Off (see
“To set the transmission mode” on page 20), or by turning
off the pager (see “To turn off your pager” on page 18).
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* The pager may be in Low Memory status. To prevent lost
incoming messages, transmission is turned off. Delete old
messages from inboxes, then empty the Trashcan to
increase the available memory. For more information, see
“Deleting Messages” on page 36, “To empty the
Trashcan” on page 43, and Low RAM on page xX).

* The battery might be too low to support two-way
transmission. Replace or recharge the battery.

Why don'’t | get alerted for incoming messages?

Your pager alerts might be set to silent. Alerts can be silenced
in two ways:

» From the menu wheel, check to see if the pager is set to
Silent mode. If so, change the mode to Loud, Soft, or
Vibrate. For more information, see “To select an alert
mode” on page 22.

* Check the alert setting for each of your inboxes. If they
are set to silent, reset the alerts. For more information, see
“To select an alert type” on page 23.

té{> If you are actively using the pager’s keyboard when
receiving a message, your keystrokes can cancel a
message'’s alert before you hear or feel the alert.

Why do | keep getting reminder alerts?

Reminder alerts notify you of unread messages waiting in your
inbox. Check each of your inboxes (Main, Information

Service, Personal) for unread messages. Read the messages or
disable the unread message alert. For more information, see
“To enable/disable the unread message alert” on page 45.

Why does my pager keep alerting me to the same
message?

Your PageWriter 2000X smart pager sometimes receives
garbled messages from the paging service provider. If you
have read a garbled message and checkeAlgrefor

improved msg®ox, your pager will update the message when
a less garbled version is received from the paging service
provider. Your pager then alerts you to the change. If the
updated version also contains garbled text, your pager will
accept additional updates and notify you of each change.
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If you have chosen not to be alerted, but have not deleted the
message, your pager will update the message without notifying
you.

If you have deleted a garbled message, you will not receive a
new message alert for any improved message transmissions.

Why are my incoming messages placed in the
wrong inbox?

Two situations can cause a message to be placed in the wrong
inbox:

* The text string you identified as your filter when setting
up the routing rules for your inbox might be too common.
Any message containing the text string you indicated will
be directed to the inbox using that filter. Detailed message
filters will help limit misrouted messages.

» If more than one inbox is assigned the same filter (text
string), the incoming message is sent to the first inbox that
contains the matching text string. Check the filters for
each inbox. See “To assign routing rules” on page 38.

Why does the sending of my messages fail?

Ensure that you have Full Service transmission. Reset the
transmission mode or, if you are out of transmission range,
wait until you are back in transmission range. Select Resend
from the Outbox to send your message.

Why are messages disappearing from my inboxes?
Messages are removed from inboxes under two conditions:

» If you do not set a cleanup schedule for your inboxes, the
auto-cleanup feature uses a default time frame of 5 days.
Cleanup rules can be set for inboxes through the Read
application. For more information, see “To assign a
cleanup schedule to an inbox” on page 39.

*  When your pager has reached Low Memory status, the
oldest read messages are deleted to free available memory
for incoming messages. The order in which messages are
deleted is discussed in “Memory Management System” on
page 71.
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Battery and Charger

The charger’'s LED doesn't light. What should |
do?

Use the following procedure to find the cause:

1. Check that your pager, or the battery alone, is inserted
into the charger correctly. See “The Battery and Charger”
on page 11 for instructions.

2. Unplug the transformer from the AC power supply.

3. Remove the pager (or battery) from the charger, then use
an ordinary pencil eraser to clean the six metal contacts on
the charger and the pager (or battery).

4. Plug the transformer back into the AC power supply to
restore the power.

5. Re-insert the pager or battery into the charger. If the
charger’s LED still does not light, have the charger
checked by an authorized service technician.

What does a flashing red indicator light on the
charger mean?

The red flashing indicator light can mean one of four
situations:

* The battery or pager may be seated improperly in the
charger. Ensure the battery or pager is properly inserted.

* The battery voltage has remained low for too long a
period of time and the battery cannot be recharged.
Dispose of the battery properly and purchase a new
battery.

* The battery temperature is outside the normal charging
range. Remove the battery and re-insert. If flashing
continues, remove the battery, wait one hour, and re-
insert. If flashing continues replace battery or have the
charger checked by an authorized service technician.

» Insufficient power is being delivered by the transformer.
Plug the transformer into another power source.

» If the insufficient power is not corrected by changing the
power source, the charger might be malfunctioning. Have
the charger checked by an authorized service technician.
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| just inserted a fresh battery, but it only lasted

2 days. Why?

When your PageWriter 2000X smart pager is set to two-way
transmission but is not receiving Full Service (i.e., you are out
of range), the pager continues to attempt to reestablish
communication with the network. This acts as a continuous
drain on the battery. Whenever you leave a two-way coverage
zone, set the radio mode to One-way or Off to preserve the
battery.

| haven’t used my pager in two months. When |
place the unit in the charger, | get a flashing red
light. Do | need a new battery?

Your battery is hyper-drained and it needs to be reconditioned.

1. Place the battery in the docking station. The light will
blink red.

2. Letthe battery sit overnight.

3. Ifthe lightis still flashingred in the morning, remove the
battery and put it back into the charger.

4. Repeat procedure until the light gagreen If after three
attempts the battery doesn't chargegteen, the battery
cannot be reconditioned and must be replaced.

FLEX PC Partner

Why can't | establish a connection between my
pager and my PC via the infrared interface?
Check the following before re-attempting to establish a
connection:

* Make sure you have opened the FLEX PC Partner

application on your pager and selec| Connect | to get
the Connect Status screen.

» Make sure your pager is placed properly in the docking
station and that the RS232 cable and transformer are
properly connected. For more information see “To
connect the docking station to your computer” on page 16.

* Make sure the communications port on your PC is
correctly set. For more information, see “To configure
FLEX PC Partner” on page 53.
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What caused my application installation to fail?

The pager may be in a Low RAM status or you may be
attempting to load an application that is close in size to the
available RAM. Remove the pager from the charger. Reset the
pager by turning it off then back on again. Rerun the
installation program.

Partner stopped working during a download and is
unresponsive. What should | do?

The battery might be drained of power. Replace or recharge
the battery, and restart the Partner download.
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Index

A
accessories, 18
activation, 5
adapter, 57

Address Book, 25, 60
add a group, 26, 68
add an individual, 26, 66
create file on PC, 63
delete entries, 29, 67
delete files, 66
edit an individual's address, 27
edit group membership, 28
edit group name, 28
editon PC, 67
file management, 63
forcing position in list to top or
bottom, 25, 68
import files, 64
import files from other PC-
based applications, 65
merge files, 64
open file on PC, 64
print, 71, 72
save file on PC, 64
save file with new name, 64
transfer data from pager to PC,
61
transfer data from PC to pager,
62
Addresses
application overview, 1
ADR files, 60
airline travel, 21
alarm clock, 53
setting, 53
Alarm Clock
application overview, 1
alarmed messages
memory management, 79
alarms, 48See alsalerts
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enable/disable, 48

reminder message, 35
alert modes, 23

icon, 6

overview, 6

shut off alerts, 6
alert types, 24, 41
alerts, 48See alsalarms

unread message, 48
Alt functions, 11
Alt-mode functions, 11

Alt key, 10
applications

delete, 53

Home screen, 5

install on pager, 74

menu wheel, 5

B

back to previous screen key, 10
Back to Previous Screen key, 10
Backlight key, 11
Backspace key, 10
backup, 75
Backup Utility, 75
Basic Service coverage, 21
icon, 7
battery, 12
icon, 7
insert into pager, 15
recharge outside of pager, 14
recharge while in pager, 15
remove, 13
safety instructions, 80
battery chargerSeecharger
battery gauge
overview, 7
book conventions, 2



C

cancel outgoing messages, 44
canned textSeeQuick Text
attach replies for addressee, 32
care and cleaning of pager, 80
charger, 12
docking station, 17
safety instructions, 81
cleanup
inboxes, 79
Cleanup, 53
Cleanup All
memory management, 79
Cleanup Inboxes, 41
memory management, 79
configuration
FLEX PC Partner, 57
infrared port, 57
pager, 20
port settings, PC, 57
connect pager to PC, 17, 57
contrast
adjust, 11, 49
calibration guide, 49
icon, 11
control keys, 9
conventions, 2
copy
data from pager to PC, 75
data from PC to pager, 76
message text, 73
create
Address Book file, 63
Quick Text, 51
signature, 51
Customize, 46
application overview, 1

D
date
format, 23, 50
overview, 6
set, 22
delayed send, 32
delete

Address Book entries, 29, 67
Address Book files, 66
applications, 53

applications from pager, 75
group’s address, 70
inboxes, 42

docking station, 17

draft messages, 33

E
edit
individual’'s address, 67
Quick Text, 51
email
create addresses, 25
individual, 66
send messages to an email
address, 30
empty the Trashcan, 46
Enter key, 10
environmental restrictions, 21

F

failed message
resend, 44

FAQs, 83

fax
create addresses, 25, 66
send messages to a fax

machine, 30, 48

service, 48

features, 1

files
backup, 75

FLEX PC Partner
application overview, 2
configure, 57
installation, 56
online help, 56
open partlets, 59
program description and

instructions, 55

FLEX PC Partner Shell
open the shell, 59
overview, 58
partlets, 58
right-click menu, 59

flip, 5

forward messages, 37, 45

Full Service coverage, 21
icon, 7
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G

Get From Pager, 61
group
add members, 26, 69
create, 26, 68
delete, 70
delete members, 70
members list, 68
rename, 28, 68

H

hardware
requirements, PC, 55
update configuration, 57
help
FAQs, 83
Internet address, 4
product support, 3
technical support, 3
holster, 18
home
Home key, 10
screen, 5
Home
phone number, 66
hospital environments, 21

icons
alert mode, 6
battery gauge, 7
new message waiting, 7
one-way transmission, 7
smart transmission, 7
special status, 7
transmitter off, 8
import
Address Book files, 64
Address Book files from other
PC-based applications, 65
Import
add to message, 31
inboxes, 38
assign cleanup schedule, 42
assign routing rules, 41
clean up, 41, 53
create, 39
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delete, 42
memory management, 78
rename, 40
save a message, 32, 37
set alert types, 41
view messages, 43
Information Services inboxes
memory management, 79
infrared port, 17
configure, 57
connect pager to PC, 57
connection, 57
insert battery, 15
installation
FLEX PC Partner, 56
new applications on pager, 74
Internet address, 4
IR. Seeinfrared port
IR port, 17

K

key click, 22, 50

keyboard, 8
control keys, 9
NavDisc, 9
Select key, 10

L

LCD screen, 5
LED alarms, 48

M

Main Inbox
memory management, 78
maximum characters allowed, 66,
67
memory
management, 78
usage level, 47, 77
memory management
alarmed messages, 79
Cleanup All, 79
Cleanup Inboxes, 79
Information Services inboxes,
79
Main Inbox, 78
Outbox, 78
personal inboxes, 78



reminders, 79
Trashcan, 78
unread messages, 79
menu wheel, 5
merge Address Book files, 64
Message Area, 38
messages
cancel, 44
canned responses, 32, 36
cleanup schedule, 40
copy text, 73
custom responses, 36
delete, 38
details, 45
drafts, 33
forward, 37, 45
print, 73
read on the pager, 34
read on the PC, 73
reply, 36
resend, 44
restore, 46
save copy of sent message, 32
save on the PC, 74
schedule send, 32
text size, 49
transfer from pager to PC, 72
write, 30
MPSHELL.EXE, 59

N

NavDisc, 6, 9
navigation
NavDisc, 9
Select keys, 10
Tab key, 9
notes, 66

O

one-time address, 33

one-way transmission
icon, 7

Outbox, 43
cancel outgoing messages, 44
forward messages, 45
memory management, 78
resend failed message, 44
resend messages, 44

view message information, 45
overview, 1
FLEX PC Partner Shell, 58
PageWriter 2000X, 5
owner information, 47

P

pager

care and cleaning, 80

configure, 20

features overview, 5

PIN, 66

reset, 19

specifications, 82

type, 66

virus protection, 80
paging service, activate, 5
partlets, 58

open, 59
PC Partner

program description and

instructions, 55-77

personal inboxesSeeinboxes
PIN

from paging service, 5
port settings, 57
power.Seecharger

off, 11, 19

on, 19
print preview, 71
printer setup, 71
printing

Address Book information, 71,

72

messages, 73

preview, 71

setting up printer, 71
product support, 3

Q
Quick Text
add to message, 31
create, 51
edit, 51

R

radio mode
set, 21
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Radio Mode

application overview, 2
Read, 34

application overview, 1
read messages

on the pager, 34

onthe PC, 73
recharge battery, 14, 15
reminder message alarm, 35
reminders

memory management, 79
remove

applications from pager, 75

group’s address, 70

individual's address, 67
remove battery, 13
replies, attaching, 32
reply to messages, 36
resend failed message, 44
resend messages, 44
reset pager, 19, 22, 84
restoration, 75
restore messages, 46
Restore Utility, 76
restrictions

environmental, 21
right-click menu, 59
routing rules, 39, 41
rules, message routing, 39

S

safety instructions, 80
save
Address Book files, 64
messages on the pager, 37
messages on the PC, 74
Select key, 10
Send To Pager, 62
service activation, 5
Set Time
application overview, 1
shell. SeeFLEX PC Partner Shell
Shift-mode functions, 12
Shift key, 10
shortcuts, 6
shut off alerts, Silent mode, 6
signature
append to messages, 51
create, 51
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sleep mode, 5
smart transmission

icon, 7
software requirements, PC, 56
Space key, 10
specifications

PageWriter 2000X, 82
status line, 7
Storing Messages coverage, 8, 21
symbols, 11
system

information, 47

setup, 19

status, 46

T

Tab key, 9
technical support, 3
text. Seelmport Message
text size, 22, 49
time
format, 23, 50
overview, 6
set, 22
transfer
Address Book data from pager
to PC, 61
Address Book data from PC to
pager, 62
Address Book information, 60
messages, 72
transmission
icons, 7
set mode, 21
status, 7
status log, 43
zones, 22
transmitter
OFF icon, 8
restrictions, 21
safety instructions, 80
Trashcan, 38, 46
empty, 46
memory management, 78
restore messages, 46
troubleshooting, 83
battery and charger, 88
FLEX PC Partner, 90
messaging, 85



PageWriter 2000X pager, 83

U

uninstall.See alsalelete

applications

FLEX PC Partner, 77
unread messages

alert, 48

memory management, 79
update

hardware, 57

Vv

version number
FLEX Operating System, 46

FLEX PC Partner partlets, 59

PageWriter 2000X
applications, 46

view message information, 45
virus protection, 80

wW

web address, 4

work phone, 66

Write, 29
application overview, 1
email, 30
fax, 30
Import Message, 31
message, 30
Quick Text, 31

Z

zones, 22
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ONE (1) YEAR STANDARD LIMITED WARRANTY
AND PROVISIONS (U.S.A. ONLY)

Motorola warrants the pager against defects in material and workmanship under normal
use and service for the period of time specified below. This express warranty is extended
by Motorola, 1500 Gateway Blvd., Boynton Beach, Florida 33426 to the original end
user purchaser only and is not assignable or transferable to any other party.

This warranty sets forth the full extent of MOTOROLA's responsibilities regarding the
pager. Repair, replacement, or refund of the purchase price, at MOTOROLA's option, is
the exclusive remedy. THIS WARRANTY IS GIVEN IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION,
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. THIS WARRANTY IS LIMITED TO THE DURATION
CHOSEN. IN NO EVENT SHALL MOTOROLA BE LIABLE FOR DAMAGES IN
EXCESS OF THE PURCHASE PRICE OF THE MOTOROLA PAGER, FOR ANY
LOSS OF USE, LOSS OF TIME, INCONVENIENCE, COMMERCIAL LOSS, LOST
PROFITS OR SAVINGS OR OTHER INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO

USE SUCH PRODUCT, TO THE FULL EXTENT SUCH MAY BE DISCLAIMED BY
LAW.

Motorola pagers are shipped from the factory with a standard limited warranty of one (1)
year on parts and labor from date of purchase by the original end user purchaser, based
on proof of purchase. In the event of defect, malfunction, or failure to conform to
specifications during the warranty period, Motorola, at its option, will either repair,
replace or refund the purchase price of the pager. Repair, at Motorola’s option, may
include the replacement of parts or boards with functionally equivalent reconditioned or
new parts or boards. Replaced parts and boards are warranted for the balance of the
original warranty period.

All parts and boards removed in the replacement process shall become the property of
Motorola. This warranty does not cover defects, malfunctions, performance failures or
damages to the unit resulting from use in other than its normal and customary manner,
misuse, accident or neglect, the use of non-conforming parts, or improper alterations or
repairs. This warranty does not cover wear and tear on covers or housings, nor the
coverage or range over which the pager will receive signals.

For information on how to receive service on Motorola pagers or covered
accessories, call 1-800-548-9954 or 1-800-793-7834 (TTY).

Pager warranty will be VOID if any of the following conditions occur:

. Pagers that are incomplete such as those in which boards or components are
missing and/or incompatible.

. Pagers whose serial numbers do not match on the boards, or pagers in which the
board serial numbers don’t match the housing.

. Pagers that have been opened by, or had work performed by, anyone other than a
Motorola authorized pager service center.

. Pagers received with non-conforming or non-Motorola housings or parts.

Flat rate repair fees apply to pagers and accessories not covered under warranty.

STATE LAW RIGHTS

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR LIMITATION ON HOW

LONG AN IMPLIED WARRANTY LASTS, THEREFORE THE ABOVE

LIMITATIONS OR EXCLUSIONS MAY NOT APPLY. This warranty gives you

specific legal rights and you may also have other rights which vary from state to state.
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